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Introduction

Logois a language for computers and people. Using Logo, beginners can get
dramatic and interesting results quickly. Experienced programmerswill find
rich material in Logo with whichto developtheirskills.

The Guide to Programmingis an introduction to Logo programming,It is Usethe guide
intended for both new computerusers and people whoalready know about
computers. This guide shows you howto build and change programs,store
and retrieve your work, and also provides examples of Logo programsthat you
can write.

Mostchaptersin this guide are divided into the following sections: “Action”,
“Reflection”, “Exploring Further”, and “Logo Vocabulary”. “Action” introduces
youto important primitive procedures — the basic words of Logo’s vocabulary
—and provides sample programs to work on at the computer. “Reflection”
gives you additional information on related Logo concepts that you can read
whenyou wanttotake a break from programming. “Exploring Further”
suggests activities to try on your own. “Logo Vocabulary”lists the primitive
procedure names, menuitems, and special characters and keys introduced in
each chapter.

 

Don’t worry if some new concepts seem unclear to you whentheyarefirst
introduced. As you becomefamiliar with Logo by working through the guide,
these conceptswill be clarified.

Note Wheninteraction with Logois shownin the guide, red text represents
what you type on the computer. Black text represents what the computer
displays.

The ReferenceManual workswith the guide to expand your understanding of Use the Reference
Logo.It provides a complete description of the Logo language and should be Manual
used for reference purposes, not as a guide for new users.
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Examine
demonstration
programs

Optional hardware

The Master Logo disk contains:
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In addition to the Logo program,there are threefiles that will be of interest to
you. Choose the Demo Menufile from the Finder for a demonstration of some
of the powerful effects you can produce with Logo. Choose the Samples Menu
file for ideas ofthe different kinds of Logo programs that you can write; more
complex programsare included inthis file. Choose the Exploring Furtherfile for
suggested program listings of the sample graphics found in each
“Exploring Further” section of tne guide.

 

What You Need

To use Logo, you need an Apple» Macintoshm computer with 128K or 512K of
memoryanda disk drive, or an AppleLisaw with MacWorksm. Any options
you may have can be useful:

@ asecond disk drive

®@ aprinter

®@ amodem

@ anything thatplugsinto the serial input-output plugs



Note All the procedures and examples in this book work withthe original
Logo productthatarrives in the package. But Logocan be easily customized
and certain commands removed.So, ifyou are notthefirst person to use the
Logodisk, don’t be upsetif the graphics instructions, for example, don’t work.
Theyare easy torestore in Logo. Refer to Appendix C, “Using the Preferences
Program”, of the Reference Manual.

 

Before You Begin

Makeatleast one copyof the master disk by moving the Master Logodisk icon
overthe icon for the other disk. See Macintosh, your owner'sguide,for details.

Weassumethat you have read Macintosh and understand the basic Macintosh
terminology: “clicking”, “dragging”, “selecting”and the use of the Menubar.
If youare notfamiliar with these terms, take time to review them now.

Before You Begin xi



 

1 Getting Started

This chaptertells you howto start up Logo andtypein instructions.

 

Starting Up

Insert the Logo disk into thedrive. Load Logo

{2} Turn on the computer.
“ay

[3] Open the Logofile fromthe Finder. ee
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Put Back
 

Close Preferences Demo Menu
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Print
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2 Getting Started

Logois loaded whenyouseethis on the screen:

7
& File Edit ‘

Graphics
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Twowindowsare displayed on the screen: one called Graphics and onecalled
Text. What you type appearsin the text window. What you draw appearsin
the graphics window.



Theflashing line on the text windowiscalled the insertion point. Thisis
where whatyoutype will appear. You can movethe insertion pointto the next
line by pressing the Return key, or to any location in the window by moving

the mousepointerandclicking the button.

 

TypingInstructions

Type a line. With the insertion pointstill on the line, press the Enter key. Logo
will treat the line as an instruction, and try to perform, or “run”it.

Forinstance, type:

hello Press the Enter key.

Logo responds:

I don’t know how to hello

Logois correct. Hello isn’t in Logo’s initial vocabulary, butthat’s not important.
You can’t hurt Logo by experimenting.

Type:

print [Greetings!] Press Enter.

Logo responds:

Greetings!

If nothing happened, you mayhave pressed the Return key, notthe Enterkey.
Thereis a big difference betweenthese keys.

The Return keysignals the end ofa line, and movesthe insertion point to the

nextline.

The Enter key takes the currentline, or a selected area oftext, and gives the
text to Logoas instructionsto run, DoIt in the Edit menu has exactly the same
function.

Typing Instructions 3

Movetheinsertion
point



4 Getting Started

Meettheturtle

 

Nowtry some graphics commands:

 

 

showturtle Press Enter.
forward 70 Press Enter.

Graphics Graphics

x

        
Youcan type several instructions at one time using the Return key
to separate them:

cg Press Return.

back 65 Press Return.
left 90 Press Return.
forward 65 Press Return.

Select those four lines with the mouse.(Point to just before CG,click and hold
the button downwhile you drag. The text will be highlighted as you selectit.)



With the lines selected, press Enter. You should see:

@ File Edit  
Graphics

 

showturtle
forward 70

m
ra
foratslae}   

Remember:

@ The Return key movesthe insertion point to the nextline

@ The Enterkeytells Logo to run the currentline or selection

Nowclear the graphics window bytyping:

|

 

Press Enter.

 

Typing Instructions 5

Rememberthe Enter
and Return keys
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Choose Help

 

See a demonstration

 

Getting Help From Logo

The Help item in the Edit menu provides information about procedure names.

To use Help, simply select the procedure nameon the text window,then
choose Help. A box will appear with the Help information. When you've read
the information,click the OK buttonin the corner.

«& File [mM e FileI
Bade

   
Help information   

   
Cut
Copy #C

Pasi¢ ‘

Clear

Back number

 

  

 

Movesthe turtle number

 

     

      
 

Selecta steps back.
Eg: back 50

T

forward 70 forward 70
ci ES

65 ens
left 90 left 90
forward 65 forward 65
cg cg  

 

 

Exploring Further: A Demonstration

You'vejust taken your first steps into the Logo world.This is a good time to
look at where those steps can lead. To see the demonstration program:

(1) Choose Load fromthe File menu.

[2] Click Workspace.

[3] Select the file named Demo Menu.

[4] Click Load.

[5] Follow the instructions that appear on the screen.



 

2 Communicating With Logo

To communicate with Logo, you type instructions. As you saw in Chapter1,
“Getting Started”, Logo responds toinstructions by producing effects on the
screen.

This chapter introduces graphics commands, most ofwhich control a
computercreature called a turtle. Graphicsis a good context in whichto start
learning Logo since youcan see how yourinstructions work. You will also
learn to open new windowsand begin doing arithmetic.

 

Action

Controlling the Turtle

Toseetheturtle on the graphics window,use the command ShowTurtle

(or ST for short ). The command HideTurtle (or HT) makestheturtle invisible.
Type:

 

showturtle Press Enter. Showtheturtle
hideturtle Press Enter.
st Press Enter.

Graphics Graphics Graphics
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Movetheturtle

Changetheturtle’s
heading

Now,movethe turtle with the Forward (Fd) command. Forward needs an
input—a numberindicating how manystepsthe turtle is to move. Try:

forward 50 Press Enter.

Noticethat the turtle changedits position, but its heading (the direction it was
facing) remained the same.

To changethe turtle’s heading, you can use the commandRight(Rt) or Left
(Lt). Like Forward, the Right and Left commands each need an input —a
numberindicating how many degreestheturtle is to turn. Type:

right 90 Press Enter.

Theturtle turned 90 degreesto the rightofits previous heading. Notice that
the turtle changedits heading, but notits position on the screen.

Back (Bk),like Forward, movesthe turtle awayfrom its current position
without changingits heading. For example:

back 80

 

Graphics Graphics Graphics

we 7 P

 

           
Left turns the turtle left:

left 45

Theturtle turned 45 degreesto theleft. Its heading changed,but not its
position. Movetheturtle forward tosee the effect of the turn:

forward 100



If you don’t like the length ofthatlast line, erase it by tracing overthe line with
PenErase(PE).

 

 

enerase Press Enter.
back 100 Press Enter.

Graphics Graphics Graphics

ey eS

ee           
Use PenDown(PD)to put the drawing pen down. Otherwise,the turtle will
continueto erase anylines it passes over.

endown Press Enter.
forward 50 Press Enter.

Homesendsthe turtle back to the center of the window,pointing straight up.

home

Atthis point, you may wantto clearthe lines from the graphics window and
experiment with the commands you have learned. CG (which stands for Clear
Graphics) erasesall the lines on the graphics window:

mg

 

Graphics Graphics Graphics 

oO

           

Controlling the Turtle 9

Erase a line

Clear graphics and
text
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Correct mistakes with
the Backspace key

To clear the text from the text window,use CT(for Clear Text):

ot

Choosing Clear from the Edit menu will also clear the text.

Fixing Typing Mistakes

If you make typing mistakes, Logo won’t understand yourinstructions and will
print a messagetotell youso. For instance,ifyou type:

frward 100

and thenpressthe Enter key, Logo will respond:

I don’t know how to frward

Spaces between a commandandits input are very important.Ifyou forget a
space, Logo won’t understand yourinstructions. For example, if you type:

right390

Logo will respond:

I don’t know how to right90

Logointerpreted right90 as one word, and printed a messageindicatingits
incomprehension.

If you’ve madea typing error, use the Backspacekeytoerase the error
and retypeto correctit.

In general, editing text in a text windowis the sameas editing text ina
Macintosh wordprocessoror other text program. The mouseis used to move
the insertion pointor to select, the Backspace keyis used to erase, and Cut,
Copy, and Paste in the Edit menu are used to moveblocksof text around.
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Printing Text on the Screen

Print (or Pr for short) is the commandthatprints text. Try:

 

print 5 Prints a number. Print text
print “Hello Prints a word.
print [Tom Jerry Seymour] Prints list.

Noticethatif Print’s input is a word, the word must be preceded bya
quotation mark.If Print’s inputis a list (a group ofwords), the list must be
enclosed in brackets.

=f

Using the Repeat Command

The Repeat commandtakesa list ofLogo instructions, and runs them again and
again,as if they had been entered separately.

Try:

repeat 6 [forward 50 back 50 right 60] Runalist of
repeat 5 Cprint [Welcome to Logo!]] instructions

@ File Edit

Graphics

 
eeText
repeat 5 [print (Helcome to Logo! 1]
Helcome to Logo!
Helcome to Logo!
Helcome to Logo!
Welcome to Logo!
piclcone to Logo!
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Remember, Repeat’sfirst input is the numberof repetitions. Repeat’s second
inputis an instructionlist enclosed in brackets.

Filling Shapes With Patterns

There are many commandsyou can useto add “special effects” to the drawings
you create. FillSh (for Fill Shape ) and SetPPattern (for Set Pen Pattern) are two
such commands. FillSh takes an instructionlist as its input (like Repeat).It fills
in the shapescreated bythe instructionsin the instruction list. To get a more
textured effect, you can give the pen a pattern to draw with. SetPPattern sets
the pen’s pattern. For example:

Fillin a shape cg

fillsh [repeat 3 [fd 70 rt 120]]

 

 

     

Graphics

Changethe pen’s pu bk 80 pd
pattern setppattern 4 The numberselects

fillsh Crepeat 4 [fd 80 rt 901] a particular pattern.

 

Graphics
 

     



setppattern 0 The penpatternis backto solid line.

SetPPattern’s inputis a number representing a pattern. Here are somepatterns
to experiment with:

 

0 1 2 3 4 3 6 ? 8 9...

(See Chapter 10, “Graphics”, in the Reference Manual for a completelist of
the pen patterns.)

Opening Windows

Whenyoufirst start Logo, there is one graphics window and one text window.
Any window maybe opened and closed using the menu bar, and named
anything you wish... as long as no other window exists by that name.

To open anewtext window:

[1] Choose Open Window fromthe File menu. A dialog box appears.

[2] Select “Text” as the kind of windowandenter any name youlike.

[3] Click the Open button.

 

 

Name of Window:

[

@rent

     
 

In the top left corner of the screen a new window appears. Click the window,
then place the pointer on the bottomright corner. With the button pressed,
drag the corner to make the window anysize youlike. Don’t cover the
graphics window — you'll erase your drawingsifyou do.

Opening Windows 13

Restore the pen’s
pattern

Opena new window
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Open a newgraphics
window

In the new window,try a few Logo commands:

c

repeat 4 [fd 50 rt 90]
print Cone small step for turtles]
print Ca giant leap for turtle-kind]

File Edit

   NewText Graphics
 

    rt |e
turt be-k ind}
kind   

 

  I   
 

 

Nowclick the close box at the top left corner of the window to makeit
disappear.

To open a new graphics window:

ff] Choose Open Window from the File menu.A dialog box appears.

[2] Select “Graphics” as the kind of window,and type any nameyoulike.

[3] Click the Open button.

 

 

Name of Window:

NewGraphics|

rest EB
® Graphics       
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The new graphics window will appear at the top left corner ofthe screen.

& File Edit ,
NewGr| Graphics

KC
 

|
   

 

pe |

To draw on the new graphics window,use the command SetCurrent. Suppose
you called the new window NewGraphics. This meansthat SetCurrent’s input

is “NewGraphics.

Try out the following instructions in the text window:

setcurrent "newgraphics Sets the new graphics window. Draw on two windows
repeat 30 [repeat 4 [fd 60 rt 901] rt 12]
setcurrent “graphics Restores the original window.

cy
repeat 30 [repeat 4 [fd 40 rt 90] rt 12]

File Edit :
NewGraphics Graphics
 

 

 

 
   

 

 

 

 

 isetcurrent “newgraphics
repeat 30 [repeat 4 [fd 60 rt 90] rt 12]
setourrent “graphics
eg
repeat 30 [repeat 4 [fd 40 rt 90) rt 12]

    eet
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Close the window

Add

Divide

You can restore the screento its original appearance by closing the new
graphics window. Make the window active by clickingit, then click the close
boxat the top left corner.

Calculating With Logo

Logo hasa full set of mathematics operationsbuilt in. To start with an easy one,

type:

ct
print 4 + 5

Logo responds:

a

Type:

print 30 / 3

Logo responds:

10

Youcan usetheresult of a calculation as an input to a command.Forinstance:

ey
forward 30+40

The turtle goes forward 70 steps.

You can draw polygons without doing the math yourself:

C
repeat 3 [fd 50 rt 360 / 3]

¢
repeat 5 [fd 50 rt 360 / 5]

 

Graphics Graphics

D> [>
ee

 

       
 



Experimentby inventing your own polygons. Polygonswill be explored in
more depth in Chapter6, “Drawing PolygonsandSpirals”. For a complete
listing of all Logo mathematical operations, refer to Chapter 8, “Mathematics”,
in the Reference Manual.

 

Reflection

Turtle Geometry

You probably think of shapesasstatic objects. But, with the turtle, geometric
shapes have a dynamic elementbecauseoftheprocess the turtle goes through
to makea shape. The basic turtle commands — Forward, Back, Right, and Left —

describe this process of constructive geometric shapes. These primitive
procedures changethestate ofthe turtle by changing its position or heading.

Inputs

ManyLogo proceduresneedan input in order to produceaneffect. In this
chapter, you have already experimented with a few: Forward, Right, Back, Left,

and Print. Ifyou forget the input and merely type:

forward

Logotells you:

Not enough inputs to FORWARD

Forward,Right, Back, and Left need a numberastheir input, while Print can use

a word,a list, or a numberasits input.

Bugs

As you learn Logo, you will inevitably make mistakes or “bugs”. Bugs indicate
that something unexpected has happened. Mostof the time you “debug” by
finding out what happenedand correctingit. Sometimes, a bug gives you a new
idea and makesyouaim fora different result. Investigating bugs can be one of
the best waystolearn.

Turtle Geometry 17
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Exploring Further

Try drawing these designs with the turtle:

 

Note The procedures which create these graphics and the graphicsin the
other “Exploring Further” sections are on the Master Logodisk,in a file named
“Exploring Further”.

 

Logo Vocabulary

Note that Logo doesn’t differentiate between capital and lowercaseletters.

Thus:

FORWARD
forward
FoRwArd
Forward

all have the sameeffect.

You can see an explanation of any of the procedure names shownin this section.
Select the name and choose Help from the Edit menu.



Commands

Back Bk
CG (for Clear Graphics )
CT (for Clear Text)
FillSh (for Fill Shape )
Forward Fd
HideTurtle HT
Home

Left Lt
PenDown PD

PenErase PE
PenUp PU
Print Pr

Repeat
Right Rt
SetCurrent

SetPPattern (for Set Pen Pattern )
ShowTurtle ST

Special Characters

“ (quotation mark) for quoting a
word

[ | (brackets ) for enclosing a list

Operations

+ (plus)
/ (divided by )

MenuItems

Clear
Open Window

Logo Vocabulary 19



 

3 Defining Procedures and Using
Subprocedures

You havealready instructed the turtle to draw a design such as a square or a
hexagon. To drawit again, you could retype all the Logo instructions. It would
be simplerifyou could type one word andget the sameresult. This can be
doneby writing aprocedure. Writing a procedure meansgiving a name to a
series of instructions. Every time you wantto run the procedure, you can just
type the procedure’s nameratherthanall the individual instructions.

 

Action

Defining Procedures

Here’s an instruction which drawsa square:

repeat 4 [fd 50 rt 90]

Here’s a longerinstruction which draws 20 squares, eachat a different angle:

repeat 20 [repeat 4 [fd 50 rt 90] rt 18]

Graphics
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Define a procedure

Youcould continue to write longer instructions that do more complex
graphics, but at a certain point, the logic becomesdifficult to follow.It is easier
to simplify instructions by separating them into individual functions and
naming them.

Theinstruction that drawsa square,for instance, may be defined as a
procedurecalled Square.

First, choose Open Editor from the File menu.

rr
© BS egit   

Graphics

 

Close Window  

    

" @ File Edit
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A new kind of windowcalled the Editor is on the screen. You can define a new Openthe Editor
procedurein the Editor. Choose a name(Square, in this instance ), then type:

to square Press Return.

To Squareis the title line. To tells Logo thatthe text that followsis part of a
procedure. Squareis the nameofthe procedure.

Nowtypethe Repeatinstruction as shown below.Endis alwaysthelast line of
the procedure.

to square
repeat 4 [fd 50 rt 90]
end

 

Editor
 

to square KH
repeat 4 [fd 50 rt 901 rq
end

     

 

While the Editoris active,it is just storing lines of Logo. It does not try to run
them.

In the Editor,all of the text-editing features like Cut, Copy, and Pastearestill
available. You can even copytext into or from a text window.

Onceyou have typed “End”, the procedure definition is complete. Press Enter.
The Editor becomesinactive. Logo responds on the text window:

SQUARE defined

Note While you are defining a procedurein the Editor, press Return to
separate eachline. If you accidentally press Enter before the procedure
definition is complete, Logo will respond in the text window:

defined
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Try the new procedure Try your new procedure by typing (on the text window):

cg Press Enter.
square Press Enter.

" @ File Edit .   

 

 
 

Editor
to square
repeat 4 [fd 50 rt 90)
end

 

    
  
 

repeat 4 [fd 50 rt 90]
repeat 20 [repeat 4 [fd 50 rt 90] rt 18]
SQUARE defined

eg
square

 
Now you can use Square as a commandlike ForwardorRight. If you turn
the turtle slightly and type Square again a new square will appear:

rt 30
square

With the name Squarereplacing the instruction Repeat 4 [Fd 50 Rt 90],
the complex Logoinstruction:

repeat 20 [repeat 4 [fd 50 rt 90] rt 18]

becomes:

repeat 20 [square rt 18]

These spinning squares mayalso be defined as a procedure.
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Click the Editor to makeit active. Choose Clear from the Edit menuto clear
this window. Thentype:

to spinsquare Title line.
repeat 20 [square rt 181]  Bodyofprocedure.
end Lastline.

Press Enter. Now clear the graphics window with CG andtry SpinSquare.

& File Edit

Editor
to spinsquare
repeat 20 [square rt 18]
end

 

 

     

 

Fixing Bugsin a Procedure

Whenyoutry out Square or SpinSquare, you may notget the expected result Edit a procedure
becausethere is a bug in the procedure. The bug may be a typing mistake,
incorrect spacing, or the absenceofan input. For instance,if there is a bug in
SpinSquare,just click the editor window. The procedureisstill there. You can
then edit the procedureto fix the bug.

If the procedure has been cleared from the editor window,you can putit back

by typing:

edit “spinsquare

in the text window. Logo will make the Editor active with only the SpinSquare
procedureinit.

Whenyouhavefinished editing, press Enter. The text window becomesactive
again, and Logo responds:

SPINSQUARE defined
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Using Square and SpinSquare,create designs like these:

 

Graphics Graphics

Se,
Lo |Poe

©,

 

o
f

%

    sa52

 

        
c
ponreverse spinsquare
spinsquare
pendown
repeat 2 [spinsquare rt 8]

Note If you hide theturtle,it will draw evenfaster.

Using Cut and Pasteto Edit

You don’t have to retype instructions each time you enterthe Editor. If there
is something youlike in a text window that you wantto define, just select the
line or lines and choose Cut or Copy from the Edit menu. Click the Editor.
Thentype To and the nameyou choose. Press Return and choosePaste from
the Edit menu.Theline orlines that you cut or copied will be pastedin at the
insertion point in the Editor. Type End onthelastline and press Enter. The
new procedure is now defined.

Drawinga Starry Sky

The powerof Logo programming comesfrom using proceduresto build other
procedures, just as Square wasused to create SpinSquare.

Click the Editor to write a procedure namedStar that draws a numberoflines
arounda single point:

to star
repeat 18 [fd 10 bk 10 rt 20]
end



 

Graphics
 

 

     
Youcan use this procedure to draw several stars, each at a different place.
To ensurethat the turtle movesto a new location before drawing each star, use
the Random operation. Random produces a random numberthat’s less than
the numbergivenas its input. On the text windowtry:

print random 6 Press Enter.

Movetheinsertion point back to Print Random 6 andpress Enter again.
A different numberwill probably result.

By using Random as an input to Forward and Right, you can turn the turtle
an unpredictable amountand movetheturtle an unpredictable distance.
Typethis procedurein the Editor:

to move
rt random 360 Random turn.
fd random 150 Random distance.
end

With Movedefined,try:

c
repeat 10 [move star]
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Use the Random
operation
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Fix a bug A bug! Theturtle drawsa line as it moves,spoiling theillusion ofa starry sky.
Edit the Move procedurebyclicking the Editor:

to move
penup Lift the pen before moving.
rt random 360
fd random 150
pendown Put the pen downafterwards.
end Press Enter to redefine Move.

Try it again:

c
repeat 10 [move star]
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Writing a Superprocedure

Nowthat a sky full of stars is working, a single procedure could run Move
and Star. The namefor a procedure whichuses other proceduresis a
superprocedure. The namefor a procedure whichis used by another
procedureis a subprocedure. Here’s a simple superprocedurecalled Sky.

to sky
repeat 8 [move star]
end

If you want morestars, change the Repeat number.



Important It’s best not to quit Logoor turn off your computer now.If you
do, you'll lose all your procedures. Before quitting, read the next chapter,
“Examining Your Workspace and Saving Files”, which explains how to save
your procedures on a disk.

Printing Your Pictures

Ifyou create a picture youlike,it’s easy to print it out on a printer. The key

combination %-SHIFT-4 prints the active window (click a window to makeit
active ). To print the entire screen, press the Caps Lock key before pressing the
36 -SHIFT-4 keys.

 

Reflection

Naming

Naming a procedureis an essential part of the Logo language. Logostarts with
a basic set of words, knownasprimitiveprocedures. Each time you define a
procedure, you add a wordto Logo’s vocabulary. This lets you customize the

language.

It is helpful to name a procedurein termsofits function. For example:

to house
walls
roof
door
end
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Total Turtle Trip

More Turtle Geometry

By now,you have probably noticed thatthe turtle turns a total of 360 degrees
when drawing a square or a triangle or whenit goes around and ends up where
it started, as in Star. A general principle of turtle geometry called the Total
Turtle Trip states that the turtle turns a total of 360 degrees to draw any closed
figure if the turtle starts and ends facing the same direction. Therefore, each
turn ofa triangle equals 360/3; a square, 360/4; a hexagon, 360/6, and so on.

Superproceduresand Subprocedures

Sky has two subprocedures, MoveandStar. Subprocedures make
superprocedures more concise and make debugging easier. When Logoprints
an error message,it indicates in which procedure the bug occurred.

Howdoes Logo run a superprocedure having subprocedures? Sky’s
instructions are run one by one. Whenthe instruction Moveis called, Move’s
instructionsare also run one by one. Whentheyare finished, Sky continues
with its next instruction tocallStar. Star's instructions are then run one by one.

sky

 

     repeat 8 [ [move] ]

penup repeat 18[ fd 10 bk 10 rt 20]

rt random 360

fd random 150

pendown

  
 

   

CommandsandOperations

There are two kinds of Logo procedures. Mostof the procedures you have
used so far are commands. Forward is the command to movetheturtle, Right
to turn, Print to print, PenUptoraise the turtle’s pen.

You havealso used the secondkind of Logo procedurecalled an operation. An
operation producesor “outputs” something to be used as an input. Randomis
an operation that produces a random number. The + sign is a familiar
operation that producesthe sum ofits two inputs.
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Operations like Random and + can onlybe used as inputs to other procedures. Usean operation
For example: as an input

print 5+ 6 11 will be printed.
fd random 50 Theturtle will go forward a random amount.

If an operationis the only thing ona line,as if it were a command, Logo
complains:

random 50
You don’t say what to do with 23

11 + 29
You don’t say what to do with 40

Thefirst word on an instruction line must always be a command.

 

Exploring Further

As you haveseen, once you have defined a procedure,it can be used as a tool
for building other procedures. Here are someideas for using SpinSquare and

Sky.

Using SetPPattern, change the pattern of squares in SpinSquare,orstars in Sky.
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FatSquares uses Move and SpinSquare as subprocedures. The command,
SetPWidth (for Set Pen Width ), changes the width oflines drawn.

to fatsquares
setpwidth 2 Sets the pen widthto2.
move spinsquare
setpwidth 4 Sets the pen width to4.
move spinsquare
setpwidth 1 Restores the pen widthto1.
end

Try using PenReverse with SpinSquare to create an unusualeffect.

 

Note The procedures which create these graphics and the graphics in the
other “Exploring Further” sections are on the Master Logodisk, in a file named
“Exploring Further”.

 

Logo Vocabulary

Commands Operations

Edit Random

PenReverse PX

SetPWidth(for Set Pen Width)

Special Words Menu Items

End Open Editor

To
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4 Examining Your Workspace
and Saving Files

Whenyou define procedures, Logo puts them in your workspace — space in
computer memory. When you quit Logo or turn off the computer, the
information in the workspaceis destroyed. To store your procedures
permanently, you must copy them ontoa disk. Procedures saved ona disk can
be comparedtofiles kept in a filing cabinet for permanentstorage.

This chapter explains how to examine your workspace, and how tosave
procedureson disk.

 

Action

Examining Your Workspace

There are several commandsthat allow you to examine your workspace.
To printthe titles of the defined proceduresthat are in your workspace, type:

pots Print out procedure
titles

for Print OutTitles.

Ifyou haven't quit Logo since Chapter3, all the procedure names you defined
are displayed in the text window.

 

 

Text
 

pots
TO FATSQUARES
TO MOVE
TO skY
TO SPINSQUARE
TO SQUARE
TO STAR

 

 
     

 

 

Note If POTS doesn’t have anyeffect, you’ve probablyjust started up Logo
and there are no procedures in your workspace for POTStodisplay. In this
case,it’s a good idea to go back to Chapter 3 and write a few procedures, so
you can try out the new commandsin this chapter.
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Print out procedure
definitions

Erase procedures

To print out the definition of a procedure, use the command POP(forPrint
Out Procedure). For example,if the Square procedureis in your workspace:

pop “square A quotation mark precedesa name.

prints:

TO SQUARE
repeat 4 [fd 50 rt 90]
END

Youcan also print the definitionsof a list of procedure names:

pop Estar sky] Brackets enclosea list.

Tolist all the procedure definitions in your workspace, use the Procedures
operation as POP’s input. Procedures outputsall the procedure names
currently in your workspace. Try:

pop procedures

The procedurelistings mayscroll rightoff the text window, but you can move
your viewing area up and downwiththescroll bar.

Erasing From the Workspace

As you view your procedures, you may notice “buggy” procedures or
procedures you no longer need and don’t wantto save, Use the command
EraseProc(for Erase Procedure ) to erase one procedureora list of
procedures.First, clean the Editor by choosing Clear from the Edit menu, so
you won’t accidentally redefine the proceduresin the Editor.

Note The namesused here are not namesof procedures you've defined,
since you don’t want to erase anything useful.

eraseproc "Fred Rememberthe quotation mark.

would erase the procedurecalled Fred.

eraseproc [setup starcircle] Rememberthe brackets.

would erase the Setup and StarCircle procedures.
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Saving Your Workspace

ChooseSave from the File menu to save your workspaceintoa disk file that
you will name.

 

 

Savein File Named:

StarShapes|

@ Workspace Gum

O window

 

Master Logo  
     
Click Workspace,then enter a name, such as StarShapes. Click Save. Now the
workspace will be saved on a disk, in a file with the name StarShapes.

Listing Files

To check whichfiles are on your disk, choose Load from the File menu. The
Load box appears. Click Workspaceto list the namesofall the program files on
the disk.

You should seethe filename you just saved on this screen ofinformation:

 

    
  Demo Menu
Graphs
Multiwindows

Quixpatterns
Samples Menu

Spirals

STARSHAPES

© Workspace
© window

     

    
  

   

     
 

Click Cancel to make the Load box disappear.
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The ErAll command

Clearing Your Workspace

Normally, you save your workspace when you'vefinished a project, or at the
end of a programmingsession. Before beginning a new projector retrieving
otherfiles from yourdisk, it’s a good idea to clear out your workspace. To do
this, use ErAll (for Erase All) .

Note Use ErAll only after you have saved your workspaceon disk.

Try:

erall

Nowtype:

pots

No proceduretitles are printed because everything has been erased.

Onceyou havesaved your procedures, you can choose Quit from theFile
menuto exit Logo without losing any of your procedures.

The Finderwill display yourfile:

@ File Edit View Special

Master Logo    

 

 

 

10 items 354Kin disk 46K available

on & &‘ v
systemFolder DemoFiles Preferences Logo Demo Menu

=~

 

Empty Folder Samples File Primitive Set STARSHAPES ‘amples Menu
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Loading Files

When you wantto retrieve your procedurefiles from a disk, choose Load from
the File menu. When the Load box appears,click Workspace and then the
filename (for example, StarShapes).

Use POTS to see whatis in your workspace now.Loading a file doesn’t erase
whatis in your workspace.Ifyou already have procedures in your workspace,
the procedures loaded from the disk are addedto those alreadyin the
workspace. Any procedure in your workspace with the same nameas one in
the file being loaded will be replaced by the new procedure.

Erasing Files

Toerase a file permanently fromdisk, use the command EraseFile
(ErFfor short). Its inputis a filename,as in:

erasefile "Fredfile

Warning Use this commandwith caution becauseits effect is permanent.

Saving and Loading Windows

The drawings in the graphics windowcan be saved in the same wayas your
workspace.If there is a picture in the window (for example, thestars ):

[i] Click the graphics window to makeit active.

[2] ChooseSavein the File menu.

[3] When the Save box appears, select Window (instead of Workspace).

[4] Enter a name, such as MyPicture.

[5] Click the Save button.
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The picture in the graphics window will be saved underthefilename you
choose.

 
 

Savein File Named:

MyPicture|

© Workspace oe

© window

 

Master Logo       
Note that graphicsfiles have a unique icon. Double-clicking this icon does not
load thefile.

 

 

 
PMYPICTURE
To load thefile back into the graphics window,simply choose Load from the
File menu, and choosethe filename. Make sure a graphics windowis active
when you wantto load a graphicsfile; otherwise, the Load boxwill display
only the namesoftext files. With a graphics window active, the Load box will
display the namesofgraphicsfiles.

For more information on workspace andfile handling, refer to Chapter 5,
“Workspace Managementand Disk Drive Control”, and Chapter 9, “Device
Management”,in the Reference Manual.
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Reflection

Distinguishing Workspace From File Space

Defined procedures exist in your workspace only while the computeris on.
Proceduresin a disk file are permanently recorded. When yousavea file, you
are putting a copy of your workspaceonthe disk. When youload a file from a
disk, you are putting a copy ofthefile in your workspace. Thefile on your disk
remains the same.

Remember, when you edit proceduresthat have already been savedin file,
you mustreplace the oldfile with the updated version or simply save a new
version ofthe file. When saving a new file, you shouldn’t use two wordsfor a
name,or use the nameofa file that already exists on the disk.

Naming Files

Mostoften,a file is a set of procedures, which are each part of the same
program. For example, the procedures in thefile StarShapesare part of the Sky
program. Giving yourfile a meaningful namehelpsyouretrieve it later. The
examples here avoid naminga file by the same nameas oneofthe procedures,
to remind youthat yourfile is a set of procedures and not only one procedure.

 

Logo Vocabulary

Commands Operations

ErAll (for Erase All) Procedures

EraseFile ErF
EraseProc ErP (for Erase

Procedure )

POProc POP(for Print Out
Procedures)

POTS (for Print OutTitles )

MenuItems

Load
Save
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5 Using Variables

Someprimitive procedures require inputs. For example, Forward needs an
input to tell Logo how manysteps to makethe turtle move;Right and Left need
inputs to tell Logo how manydegreesto turn the turtle. The function of these
primitives is constant. When executed, Right alwaysturns the turtle clockwise.
However, the inputto Right is variable. Whatevervalueis given as Right’s
input determines the amountthe turtle turns.

CTis a primitive procedure that requires no input. The defined procedures
SquareandStar, like CT, need no inputs. Square and Star produce exactly the
sameactions on the screen each timetheyare run.

If you wantedthe turtle to draw squaresofdifferent sizes, you could write a
series of procedureslike Square 10, Square20, Square30,etc., but that would be
cumbersome.Instead of many proceduresto draw squaresof specific sizes,
you can define a general procedurethat will draw squaresofany size, by
writing a procedurethat uses an inputto specify the size of the square. This
meansthat:

Square 20 will make a small square
Square 200 will make a huge square



42 Using Variables

Whatis the : (colon)?

Addaninput to Square

 

Action

Defining Procedures With Inputs

Choose Load from the File menu andselect the StarShapesfile that you saved
in the previous chapter. Now edit Squareto give it an inputforits size:

edit “square

If the Square procedureis in your workspace,it will appear in the Editor:

TO SQUARE
ee 4 (fd 50 rt 90]
EN

The length of each side of the square is determined by Fd’s input. To make the
procedurecreateall sizes of squares, Fd’s input must be madevariable. This
can be doneby giving a nameto the input. The name Size would be
appropriate. Replace 50 with :Size in the procedure. The : (colon) preceding
Size tells Logo thatSize is a namethat represents a value, not the nameofa
procedure. Think of the : (colon) as saying “the thing thatis called”.

TO SQUARE
pepeet 4 [fd :size rt 90]

EN

An importantdetail — on the title line (To Square), you must indicate that

Square hasan input called Size. This is what the new Square procedure should
look like:

TO SQUARE :size ‘Size onthetitle line.
repeat 4 [fd :size rt 901] ‘SizeasFd’sinput.
END
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Press Enter to define the revised procedure,thentry it:

Square 10
square 20
square 30
square 40
square 50

 

Graphics
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Whathappensifyou forget to give Square an input? If you type:

square

Logo responds:

Not enough inputs to SQUARE

Checkingfor Possible Bugs

If your new Square procedure doesn’t work, check for the following bugs:

@ No: (colon) preceding Size

™@ Aspace between: (colon) and Size

@ A typing mistake. For example,:Size on thetitle line and :Sise within the
procedure

@ When running Square, you put a: (colon) preceding the input number.For
example, Square :50
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Define a procedure
with two inputs

Add aninputto Star

Defining a Text Procedure With Inputs

Inputs are useful for all kinds of defined procedures,notjust graphics. An input
can be a wordora list as well as a number. For example, define a new
procedure called Many that has two inputs.

to many :times :message
repeat :times [print :message]
end

Note Usethe horizontalscroll bar to see a line that’s longer than the editor
window width.

Try:

many 3 “Judy

Logo responds:

Judy
Judy
Judy

Since Print will print words, numbers,orlists, Many’s second input can be any
ofthese. Since Repeat’sfirst input must be a number, Many’sfirst input also
mustbe a number.

many 10 [Alphonse Q. McKoy]
many 10 2000

Creating a Variable Sized Star

NoweditStar to take an input.

edit “star

If the Star procedureis in your workspace,it will appear in the Editor:

TO STAR
repeat 18 [fd 10 bk 10 rt 20]
END

Edit Star and add an input for the length of the lines:

TO STAR :length :Length onthetitle line.
repeat 18 [fd :length bk :length rt 20]
END :Length as inputfor Fd

and Bk.
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Now try:

star 10
c
star 50

 

Graphics Graphics
 

*

        
You may wantto edit Sky so you can choosethesizeofstars in the sky. Here
are the original definitions ofSky and Move(Sky’s subprocedure):

TO SKY
repeat 8 [move star]
END

TO MOVE
penu
rt random 360
fd random 150
endown
ND

Ifyou run Sky as is, Logo complains:

Not enough inputs to STAR in SKY

Ofcourse,Star requires an input in order to work.Sky also needs an input on
thetitle line:

TO SKY :size Input onthetitle line. Add aninput to Sky
repeat 8 [move star :size] InputforStar.
END
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Experiment with Sky now:

sky 40

 

Graphics
 

 

     

You may wantto add anotherinput to Sky — the numberofstars to draw:

TO SKY :amount :size
repeat :amount [move star :size]l
EN

Rememberthat Sky now takes two inputs when yourunit:

e
aby 35 10 35 is the Amount.

10 is the Size.

 

a
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Reflection

Theidea of variables is a powerful one. Variables allow you to make your Useinputs as
procedures, whether they manipulate graphics, text, or numbers, more variables

flexible. A variable in a graphics procedure may allow youto vary its size with
the same procedure. To help you rememberwhata variable does, use a
meaningful name,like Size.

Whenyou defined Square, you wanted to give Forward an input ofsome
variable number, so you namedit Size. Naming an inputlets yourefer to it in
general terms. In Logo, :Size refers to whatever happensto have the value of
Size. How do yougive Size a value? When you type Square 10 or Square 25,
Size takes the value of 10, 25, or whatever numberyoutypeas input.

Thevalue of a variable can be passed from a superprocedure to a
subprocedure. For example, the Sky procedurepassesthe valueof:Size to Star.

 

Exploring Further

Try other waysofusing variables. For example:

@ Circle with inputfor Size

@ Arcs of Circles with inputs for the size and degreeofthe arc

 Note The procedures which create these graphics and the graphicsin the
other‘‘Exploring Further’’ sections are on the Master Logo disk,ina file
named“Exploring Further’.
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Logo Vocabulary

Special characters

: (colon) for “the thing thatis called”



 

6 Drawing PolygonsandSpirals

Just as you can vary the numberofsteps the turtle takes, you can also vary how
muchit turns. In fact, you can produce some beautiful and surprising designs
by varying both these components. A procedure for drawing polygons which
takes these componentsasinputs will be defined in this chapter. This

procedureis recursive; it runsitself as a subprocedure. The chapterwill also
suggest ways of experimenting with and exploring polygons.

 

Action

Drawing Polygons

The Poly proceduretakes twoinputs: one for the numberof turtle steps; the
other, the amountto turn:

to poly :step :angle
fd :step
rt :angle
poly :step :angle The recursiveline.
end

Thelast line of Poly before Endis the recursive line. Thisis an instruction to
run Poly as a subprocedure.

49

Whatis the recursive
line?
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Stop a recursive
procedure

Nowtry it! (Show theturtle before running Poly so you canseethe process.)

poly 60 90

@ Hie it

finde #2 Graphics
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A square! ChooseStop (from the Edit menu ) to stop Poly. Stop signals Logo to
stop whatit is doing.

Try Poly with other inputs. For example:

poly 60 120
poly 60 72
poly 75 160

>
As you changethe Angle input, notice that the shape of the polygon changes.
Experimentwith other inputs for Poly. How manydifferent kinds of shapes can
youproduce? Try to predict the kind of polygonaparticular angle will
produce.



Defining a Sun

Defining a Sun

The Sun procedure resembles Poly exceptthat it moves the turtle back before
turning. Its designslook like sun rays becauseofthe inputs for the forward
step, back step and turn. Hereis Sun’s definition:

to sun :fdstep :bkstep :turn

fd :fdstep
bk :bkstep
rt :turn
sun :fdstep :bkstep :turn_ The recursiveline.
end

The recursive line instructs Sunto runitself as a subprocedure.

Try:

sun 70 60 20
sun 30 50 25

  
ChooseStop to stop the procedure.

Try other inputs. Whatwill happen if Sun’s second inputis zero? Whatwill
happenif FdStep and BkStep are equal?

51
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Use comments
in a procedure

Drawing Spirals

Both Poly and Suninstruct the turtle to draw closedfigures. The turtle goes
forward and rotates to get back to whereit started.

To draw a spiral, the turtle should not go back to whereit started. Instead, the
turtle should increase its forward step on each roundso that it movesfurther
and further away from its starting point.

Dothis by slightly increasing the value of Step on the recursive line. Edit Poly
to define Spi by changingthetitle and recursive lines.

Add a commentin the procedure definition to help you (or someoneelse )
understand what the procedure does. A commentis a line following a
semicolon(;). The semicolon signals Logo to ignoretherestof theline.

to spi :step :angle Thetitle line.
fd :step
rt :angle
3step increases on each round Thecomment.
spi :step + 3 tangle The recursive line.
end

Notice the difference in the recursive lines of Spi and Poly. Poly’s recursive
line is an exact copyofits title line. This means that each roundofrecursion is
exactly like the previous one. Spi’s recursive line is not an exact copy:3 is
addedto the value of Step. When each Spi subprocedureruns,it draws a
longerside.
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Now,experiment with Spi. (ChooseStop to stop. )

spi 5 90
spi 0 122
spi 5 160

 

 

 

 

 

 

[e]
              
     

 

You can make Spi more interesting by making the increment +3 variable. This
will becomea third input namedInc.Spi will add :Inc to :Step, instead of3. :Inc
will allow you to vary the amount added to the numberofturtle steps by
choosing different numbersfor its input.

to spi :step tangle :inc
fd :step
rt :angle
;step increases on each round

spi i:step + :inc :angle :inc
end
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For example:
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Try varying the third input to producedifferent effects.

 

Reflection

Experimenting

Throughoutthis book, you are encouraged to experimentwith ideas other
than those presented here. However,it is not always obvious how to explore
the primitive procedures and concepts presented. This chapter provides you
with three procedures that produceexciting effects. You can explore Poly, Sun,
and Spi graphically to create exciting designs, or write your own procedures to
produceotherrecursive designs.



Total Turtle Trip Revised

According to the Total Turtle Trip, the turtle will turn a total of 360 degrees to
complete the trip around anyclosed figure whenthe turtle starts and ends
with the sameposition and heading.

However,ifyou follow the turtle’s trip around a star polygon, you'll notice an
aberration. For example, Poly 50 144,a five-pointed star, makesthe turtle turn
a total of 720 (144 « 5) degrees. The turtle completesa full rotation twice.
Whenturning aroundthe third pointofthestar, the turtle rotates through its
initial heading. Verify this phenomenonfordifferent stars. The Total Turtle
Trip must now berevised as follows:

Theturtle will turn a total of 360 degrees or a multiple of360 degrees to
complete the trip around any closed figure when the turtle starts and ends
with the sameposition and heading.

Recursion

You have seen a few examples of recursion: Poly runs Poly as part ofits
definition, Sun runs Sun, and Spi runs Spi. Whatis recursionall about?

Considerthis recursive riddle:
Ifyou had two wishes, what would your second wish be?
Answer: Two more wishes.

Nested Russian dolls is another example which works muchlike Spi. A painting
inside anotherpainting, a movie within a movie, a story within a story like “A
Thousand and One Arabian Nights”, are all examples of recursion.

Thenotion that recursion continuesforever gives us a chance to play with
infinity. The easiest way of making a recursive procedurestop is by choosing
Stop from the Edit menu. The next chapter explores ways ofembedding a
“stop rule”in a recursive procedure, enabling you to specify the condition
whenthe procedurewill stop.
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Exploring Further
 

Modify Spi so it draws from the outside in rather than from theinside out.

Try Spi and Poly with different pen patterns.

Whatwill happenifSpi increases the angle instead ofthe forward step? Write a
procedure to experiment.

Write a Shrink-Grow procedurethat alternately decreases and increases the
forward step while keeping the angle constantat 90 degrees.

 

 

Note The procedures whichcreate these graphics and the graphics in the

other“Exploring Further”’ sections are on the Master Logodisk,in file
named “Exploring Further’’.

 

Logo Vocabulary

Special Characters MenuItems

; (semicolon) for a commentline Stop



 

7 Exploring Recursive Procedures

This chapter discusses various kinds of recursive proceduresand different
ways of stopping them within the procedures themselves.

 

Action

Creating Stop Rules

Recursive procedures suchas thoseillustrated in the previous chapter won't
stop unless you choose Stop. For example:

to spi :step :angle :inc
fd :step rt :angle
spi :step + tine :angle :inc
end

Try:

spi 10 1235

Youmust chooseStop to end the spiral. However, you can modify this
procedure to stop another way.In fact, creating appropriate stop rulesis an
essential part ofwriting recursive procedures.

Note If you encounter the Not enough symbol space message, use the
Recycle command.Recycle clears all unneccessary symbols from your
workspace. For more information, see Appendix D, “Memory Space”, in the
ReferenceManual.
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The > (greater than)
operation

Place the stop rule

Writing a Stop Rule for Spi

Suppose you decide that Spi should stopif the length ofa side (:Step) is greater
than 175. Then, insert this line in the procedure:

if :step > 175 [stop]

Whereshould the stop rule be placed? Try putting it immediately after the title
line:

to spi :step :angle :inc
if :step > 175 [stop] The stop rule
fd :step rt :angle
spi :step + :inc tangle :inc

end

Run Spi 10 123 5. Experimentwith placing the stop rule on differentlines of
the procedure. What happensif the stop rule is at the end of the procedure?
Doyougetdifferent effects? Experiment also with changing thelimit of :Step in
the stop rule; for example, 250instead of 175.

Writing a Stop Rule for Poly

Writing a stop rule forPoly is a little trickier. Poly lookslike this:

to poly :step :angle
fd :step
rt :angle
poly :step :angle
end

Poly completesa figure whentheturtle returns toits starting state — its
original position and heading. This meansthat the turtle must turn 360 degrees
or a multiple of 360 degrees.

You need to know whatthe turtle’s heading is whenit starts, and then compare
that to theturtle’s heading after each turn. The primitive procedure called
Headingwill help you do this. Heading is an operation that outputstheturtle’s
heading as a number between 0 and 360.So, before running Poly, make Logo
rememberthe turtle’s heading. Do this by naming the heading Start with the
Name command:

name heading "start Headinggivesthe turtle’s
current heading.
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Name's secondinputis the name weare giving to the information produced by The Name command
Heading. Since Startis a name,it is preceded by a quotation mark. To see the
informationStart contains, put a : (colon) in front ofStart.

print :start

If the graphics window has just been cleared, Logo responds:

0 Theturtle is pointing straight up.

The following stop rule for Poly checks thatthe turtle’s current heading (the
directiontheturtleis facing at that moment) is the same as:Start.

if heading = :start [stop]

Whenyou putthis stop rule into the procedure, makesureit’s placed after the
Rt command.Ifyou put the stop rule before the Rt command,Poly stops
immediately, before the turtle starts drawing!

to poly :step rangle Place the stop rule

fd :step
rt :angle
if heading = :start [stop] The stoprule.
poly :step :angle
end

Now,try Poly.

Thereis a problem here. You must rememberto namethestarting heading
before you run Poly, or the stop rule will not work.

It is best to put that action into a procedure. Write a superprocedure called
SuperPoly which gives Start a value and then runsPoly.

to superpoly :step :angle
name heading "start
poly :step :angle
en
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Give Poly
a third input

Use Heading as an
input

Create text triangle

The ButFirst operation

Now SuperPoly does the wholejob.

Another wayto give Start a value is to add the input:Start to the title and
recursivelines:

to poly :step :angle :start ‘Start onthetitle line.
fd :step rt :angle
if heading = :start [stop]
poly :step :angle :start ‘Start on therecursiveline.
en

To run Poly, you mustalso giveit a third input whichrefersto thestarting
heading. This input can be the operation Heading. This way, Logo calculates
the starting heading, which becomesthe valueofStart. For instance:

rt 90
poly 90 144 heading

If you don’t wantto type Heading each time you run Poly, make SuperPolyits
superprocedure.

to superpoly :step :angle
poly :step :angle heading
end

Writing a Stop Rule for Words andLists

This simple recursive procedure removes oneletter at a time from a word
(or one wordat a time froma list). It creates a kind oftriangle.

to triangle :object
print :object
triangle butfirst :object
end

ButFirst (or BF ) outputsall butthe first elementof its input. With ButFirst on

the recursive line, ;Object loses one element each time Triangleis called.
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Triangle has a bug. Logo complains because :Object becomes an empty word —
a word with no characters. ButFirst tries to take this empty word as its input.

This bug can be fixed by making Triangle stop whenits input is empty. The
stop rule to do thisis:

if emptyp :object [stop]

EmptyP(P standsfor Predicate ) outputs Trueif its input, a wordora list,is The EmptyPoperation
empty (contains no elements).

Where should the stop rule be placed?

This example makesthestoprule thefirst line after thetitle line in Triangle:

to triangle :object Place thestop rule
if emptyp :object [stop] The stoprule.
print :object
triangle butfirst :object
end

Experimentwith placing the stop rule after the Print line.
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Add graphics
instructionsafter the
recursive line

Now,try:

triangle "Logo

triangle [going going going gone]

AddingInstructions After the Recursive Line

Procedures ending with a recursive line are not the only kind of recursive
procedures.In fact, instructionsafter the recursive line produce powerful and
sometimes unexpected effects.

This different kind of spiral stops at a specified heading:

to curl :step :angle :heading
fd :step rt :angle
if heading = :heading [stop]
curl :step + .5 :angle :heading
end

For example,try:

curl & 15 270

curl 5 15 0

For variation, add a few moreturtle actionsafter the recursive line. For

example, edit Curl to add:

fd :step lt :angle

and change Curl’s nameto Surprise on thetitle and recursivelines:

to surprise :step :angle :heading
fd :step rt :angle
if heading = :heading [stop]
surprise :step + .5 tangle :heading
fd :step lt sangle The newline.
end
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Whatdo you expect will happen?

surprise S 15 270

Surprise 5 20 0

Experiment with different inputs.

Nowadd Print :Objectafter the recursiveline in Triangletoseeits effect.
Change Triangle’s nameto Tri2:

to tri2 :object
if emptyp :object [stop]
rint :object

tri2 butfirst :object
print :object The newline.
end

Predict what the newline will printifyou run Tri2 “Logo.

Nowtry it.

 

Reflection

Conditions, Actions, and Predicates

The Ifcommand needstwo inputs: a condition and an action that is carried out
if the condition is True. An actionis a list of Logo instructions. Like otherlists,
it’s enclosed in brackets [_ ]. The condition is expressed with a special kind of
operation called apredicate, a word that asks whether something is True or
False. The P in EmptyP remindsyouit’s a predicate. Some other Logo
predicates are > (greater than) and = (equals).

Add a Print instruction
after the recursive line

Whatis a predicate?
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Recursion With Wordsand Graphics

Comparetheeffect of a recursive procedurelike Triangle with a graphics
procedurethatspirals inward.

to triangle :object Prints a text triangle.
if emptyp :object [stop]
print :object
triangle butfirst :object
end

to spiralin :step :angle Draws spiral
if :step < 1 [stop]
fd :step rt :angle
spiralin :step - 2 :angle
end

For example:

spiralin 90 90

 

Graphics

el

 

   

            

     
In Triangle, ButFirst on the recursive line removesthefirst elementofits input
each time Triangle is called. In Spiralln, Step — 2 on the recursive line makes
the line drawn by the Fd commandshorter each timeSpiralInis called.

Thestop rule in Triangle uses the EmptyP operation to checkif the wordorlist
is empty of elements. Another way to determineif a wordorlist is empty is to
check whether the numberofelementsis 0. In SpiralIn, the stop rule checksif
:Stepis less than 1.



Thinking About Recursion

Run Tri2 “go and look at the result. The following telescoping model mirrors
that result. The “Process” column showsthe process, or flow of control for
Tri2 “go. The “Result” column showstheresults that are printed on the
window.

 

Process Result
 

    
go

tri2 bf “go

tri2 "0

if emptyp "o [stop]

print "o nn
tri2 bf “o

tri2 "

 

if emptyp "

print "o rssaesecnmorste QD

end   
  

Remember:the recursive line is where Tri2 runsitself as a subprocedure.

WhenTri2 “ stops, each subprocedure(Tri2 “o and Tri2 “go ) must finish. This
means running the remaininglines of the procedure definition.

Thinking About Recursion 65
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Exploring Further

Write your own recursive procedure. Add someactionsafter the recursive line
and checktheresults.

 

Note The procedures which create these graphics and the graphics in the
other‘‘Exploring Further’’ sections are on the Master Logodisk,in file

named‘Exploring Further’’.

 

Logo Vocabulary

Commands Operations

If = (equals)
Name > (greater than)

Stop < (less than)
Recycle ButFirst BF

EmptyP (P for Predicate)
Heading



 

8 Creating a Bar Graph Project

In this chapter, you will develop a project to draw a bar graph. You'll learn
several new programmingideas: the interactive program, the technique for
printing text on the graphics screen, and manipulating windows under
program control.

The interactive program creates a dialog between the computerand the
personat the keyboard. An interactive Logo program can be written so
everyday English words and sentencesare used for questions and answers.

 

The Scenario

Hereis an example of a bar graph program whichusesinteraction to draw the
bars.

The turtle drawsthe axes of the graph.

67
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Then Logoasks:

How many computers were sold in 81?

You type:

1000

Logo calculates a distance to represent 1000,and the turtle drawsthefirst bar
ofthat height.

Logoasks:

How many computers were sold in 82?

You type:

2000

Logocalculates the distance and the turtle draws the secondbar.
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Logo asks:

How many computers were sold in 83?

You type:

5000

Logo calculates the distance andthe turtle draws the third bar.

Logoasks:

How many computers were sold in 84?

You type:

10000

The turtle draws the fourth bar.
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The Plan

Planning is an importantpart of a programmingproject. Before starting a
projectlike this one,dividethetask intoits logical steps:

Step 1: Set up the windows.

Step 2: Draw thepicture:
* of the axes, with a markedscale onthey-axis.
* of the bars, side by side on the graph.

Step 3: Make the program interactive by using data from the keyboard to
determine the height of each bar.

Step 4: Label the graph and each bar.

Step 5: Write a superprocedure, putting everything together in an easy-to-use

way.

Step 6: Addthefinishing touchesto the program by controllingtheinitial
windowset-up.

Note listing ofall the procedures making up the bar graph program can be
foundat the endofthis chapter. Thereis also a diagram showingthe structure
of the program.

 

Action

Step 1: Setting Up the Windows

In any project, it is necessary to set up the initial conditions for running the
program.Atthis point, this meansclearing the text and graphics windows and
hiding the turtle before drawing the graph. Hereis a simple SetUp procedure:

to setup
recycle Recycle the memory.
ct Clear the text.
cg ht Clear the graphics.
end
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Step 2: Drawing the Axes and the Bars

They-axis will have a scale markedalongit. It’s useful to have a general
procedurethat drawsthe marks. Theinterval for the scale marks is variable:

to drawmarks :int
repeat 120 / :int [fd :int rt 90 fd 5 bk 5 1t 901
end

Nowwrite a procedureto draw the y-axis, giving it a scaling interval as input.
(DrawMarks will be a subprocedure of the YAxis procedure. )

This procedure uses SetHeading (SetH for short) to change theturtle’s heading. The SetHeading
SetHeadingsets the turtle’s heading in absolute termslike a compass — 0 is command
straight up.

to yaxis :scale Draw they-axis
setheading 0 Sets the turtle’s heading.
drawmarks :scale Drawsthe marks.
bk 120
end

Try:

yaxis 20
cg yaxis 10
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XAxis does not have a subprocedure,since it doesn’t need markedintervals:

 

 

 

      

Draw the x-axis to xaxis
setheading 90 Sets the turtle’s heading.
fd 200 bk 200
lt 90
end

Try it:

xaxis

Graphics

The SetPos command SetPosis a commandthatsets the turtle’s position in terms of x and y
coordinates.[0 0] is the center of the graphics window:

pu setpos [-100 -55] pd

Use the Pos operation to checktheturtle’s position:

print pos

Logo responds

“100 -55
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DrawAxesis the superprocedure.It sets the starting position for the axes, and
runs YAxis and Xaxis.

Hereis the definition for DrawAxes:

to drawaxes :startpos :scale
3x and y axes
;starting position is bottom left
pu setpos :startpos pd Sets the starting position
yaxis :scale
xaxis
end

Try out:

drawaxes [-100 -55] 15

 

Graphics
 

    
 

Use SetPWidth to set the width ofthe bars. (The PWidth operation outputs the
current pen width.)

The procedure to draw onebar has :Height as its input. After the turtle draws a Draw onebar
bar, the procedurereturnsthe turtle’s line to its normal width.

to bar :height
s;draws a wide line for a bar
setpwidth 20 Sets pen width to 20.
pu fd 10 a, d Centers the wide pen above theaxis.
ue theig

neigh
° bk 1 Centers the narrow penontheaxis.
setpwidt a 1 Sets pen width back to normal.
end
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The ReadWord
operation

To place the turtle to draw eachbarside by side, use the Position procedure.

to position :distance
smoves turtle to draw next bar

rt 90
pu fd :distance pd
lt 90
end

Now,type:

setu
drawaxes [-100 -55] 15
repeat 4 [position 40 bar 100]

 

Graphics
 

     
Step 3: Determining the Bar Height

ReadWord (RW for short) reads a word or a line ofwords typedat the
keyboard and outputs the information to another procedure. For example,if

youtype:

print readword Press Enter.

the insertion point waits at the beginning of the nextline for you to type
something. You may type:

echo Press Enter.

Logo responds:

echo
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Since ReadWordis an operation,it is used as an input to another procedure. In
this case, the word you typedat the keyboard wasgivento Print. Print then
printed the word.

You can namethe output of ReadWordso that Logo will storeit for future use.
To do this, use Name:

name readword "message

Youtype:

Hello

This time, the wordisn’t printed again. When youtype:

print :message

Logo responds:

Hello

Theline typed at the keyboard was picked up by ReadWord and stored under
the name Message. When you asked Logo to Print :Message,it printed the line.

In the bar graph project, ReadWordis used to pick up a numberso this
information can be convertedinto an inputfor Bar.

Now,write a procedure that uses ReadWordto get the number ofcomputers
that the companysold in a year. The year can be an input which will be passed
from the superprocedure.

to baramount :year
;gets a number and draws a bar
print se [How many computers were sold in] :year
name readword / 100 “height Gets an answer.
position 40 Positions the turtle.
bar :height Drawsthe bar.

end
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The Sentence In BarAmount, Sentence(or Se) combinesits inputs into list.
operation

To run BarAmount,give the year of your choiceas input for now.

baramount 82

This question appears:

How many computers were sold in 82

Ifyou type:

5000

Logo drawsa bar 50 steps high (5000 / 100 = 50).

@ File Edit   : Graphics

Editor
To baramount :year
gets a number and draws a ba
print se [How many computers
name readword / 100 “height
position 40

4 bar sheight
end

 
 

setup
baramount 1982
How many computers were sold in 1982
pe   
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Step 4: Labelling the Graph andthe Bars

In any bar graph,it’s a good ideato label the graph andthebars.

Printing text on the graphics windowis almost the sameas printing on a text Print on the
window.Since Logo normally prints on the current text window,a special graphics window
commandis needed to direct printing somewhereelse. Use the SetWrite
command:

setwrite "graphics The SetWrite
print [Chere I aml] command

Graphicsis the nameof the window.After being given this instruction, the
Print commandprintsits input on the graphics window.(Ifyour graphics
windowis named something other than “Graphics”, give its actual name as

input to SetWrite.)

On graphics window,printing in any available fontis possible:

setfont "Venice Sets the printing font. Changethe
setstyle [0 14] Changestheprinting style. printing font
print [pretty fancy!]

 

Graphics
 

here | am

pretty fancy!

    
 

setfont "Monaco Restores the original font
setstyle [0 9] andstyle.

For more information onfonts and printing styles, see Chapter 10, “Graphics”,
of the ReferenceManual.
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The SetCursor
command

Write a general
graphicsprinting
procedure

Give title to the
graph

Toreturn printing to the text window,type:

setwrite "text

Printing on the graphics windowstarts from the cursorposition. The
SetCursor commandis usedto position the cursor on the graphics window,
just as SetPospositionsthe turtle. The GrPrint procedure takes two inputs: the
wordorlist to print as a label on a graphics window,and the cursor’s position.

to grprint :position :label
setwrite “graphics Sets the graphics windowforprinting.
setcursor :position Sets the cursor’s position.
print :label Prints thelabel.
setwrite "text Restores the text windowforprinting.
end

Ifyou wantto placethetitle “ComputerSales” just above the bar chart, type:

grprint ([-50 70] [Computer Sales]

Now use the GrPrint procedure to put the year labels on the bars of the graph.
GrPrint should be added as a subprocedure to BarAmount. The reasonfor this
is thatit’s easy to calculate the position for printing. After each bar has been
drawn, theturtle is on the x-axis of the graph,at the position of the bar. The
Pos operation outputstheturtle’s position:

print pos

The printing cursor can be moved to wherevertheturtle is by using the output
from Pos, as the input to SetCursor.Try it:

setwrite “graphics
setcursor pos Sets the cursorto the turtle’s position.
print CWhere’s the turtle?]
forward 100
setcursor pos Sets the cursorto the turtle’s position.
print CHere’s the turtle]
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Graphics
 

Computer |Sales

Ihere's the turtle?

gere'= the turtle

1
    
 

Onthe graph, you wantto printthe label below each bar. That can be done by
backing the turtle up 15 steps before setting the cursor, then movingit
forwardagain.

 

to baramount :year Labelthe bars
s;gets a number and draws a bar

print se [How many computers were sold in] :year
name readword / 100 "height
position 40
bar :height
s;labels the bar
pu bk 15 pd Backstheturtle up.
grprint pos :year Labels the bar.
pu fd 15 pd Restores theturtle’s position.
end
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Step 5: Writing the Superprocedure

Finally, you need a superprocedureto putall the subprocedures together.
Write this procedure using the years of your choice as inputs to BarAmount:

to bargraph
setup
drawaxes [-100 -55] 15
grprint ([-50 701 [Computer Sales]
baramount 81
baramount 82
baramount 83
baramount 84
end

Now runit by typing:

bargraph

Enter any four numbersto draw the fourbars. The resulting graph will depend
on the inputs yougive.

 

Graphics
 

Computer Sales

81 82 83 84    
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Step 6: Setting Up the Initial Windows

Once your program works, you maywantto add somefinishing touches. To
make your new program little more “user-friendly”, it’s a good idea to
expand the SetUp procedure.It’s possible that the graphics window has been
changedin size or hidden behind other windows. Therefore, SetUp should:

1. Set the size and position of the graphics window, andclearit off.

2. Set the size and position of the text window,andclearit off.

The commandswhichset the size and position ofwindowsare SetWSize (for The SetWSize
Set Window Size ) and SetWPos(for Set Window Position ), SetWSize takes two command
inputs: a name,so it knows which window to move,and list of two numbers,

the width and the height of the window.If the graphics window named
Graphicsis still on the screen,try:

setwsize “graphics [200 200]

The window just became a 200 by 200 square. Notice that you set the size of
the “documentportion”of the window;thatis, the part of the window that
you can use, excludingthetitle bar and the scroll bars.

SetWPosalso needs twoinputs: the nameof the window to be movedandits The SetWPos
new location in x-y coordinates. However, the coordinates are not graphics command
windowcoordinates, they are screen coordinates. In screen coordinates,[0 0]
is the top left corner of the screen. Try:

setwpos “graphics [80 40]

The window movedto the top of the screen (a y-coordinate of 40), near the
left (an x-coordinate of 80 ). Again youset the position of the document
portion of the window.

Edit SetUp to set the size and position of the graphics window:

to setup
recycle
ct
cg ht
setwpos "graphics [240 40] Sets the location of Graphics.
setwsize "graphics [250 2701] Sets the dimensionsof
end Graphics.

Try it out. To find out if Setup really works, move the window or makeit
smaller with the mousefirst.
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Nowsetthe position andsize of the text window. The nameofthe text
window when Logostarts up is Text. If you’re using a text window with
another name,use that nameas input. Edit SetUp again:

to setup
;clears and positions the windows
recycle
et
cg ht
setwpos “graphics [240 40]
setwsize "graphics [250 270]
setwpos “text [10 220] Sets the location ofText.
setwsize "text [210 90] Sets the dimensionsofText.
end

" @ File Edit
Graphics

  

aSsSSlet aS]

   

 



Program Listing

to bargraph
setup
drawaxes [-100 -55] 15
grprint [-50 70] (Computer Sales]
baramount 81
baramount 82
baramount 83
baramount 84
end

to setup
s;clears and positions the windows
recycle
et
eg ht
setwpos “grahics [240 40]
setwsize "graphics [250 270]
setwpos "text [10 220]
setwsize “text [210 90]
end

to drawaxes :startpos :scale
3x and y axes
s;starting position is bottom left
pu setpos :startpos pd
yaxis :scale
xaxis
end

to yaxis :scale
setheading 0
drawmarks :scale
bk 120
end

to xaxis
setheading 90
fd 200 bk 200
lt 90
end

to drawmarks :int

repeat 120/:int [fd :int rt 90 fd 5 bk S lt 90]
end

Program Listing 83
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to baramount :year
3gets a number and draws a bar
pr se CHow many computers were sold in] :year
name readword / 100 "height
position 40
bar :height
;labels the bar
pu bk 15 pd
grprint pos :year
pu fd 15 pd
end

to position :distance
smoves turtle to draw next bar
rt 90
pu fd :distance pd
lt 90
end

to grprint :position :label
setwrite "graphics
setcursor :position
print :label
setwrite "text
end

to bar :height
;draws a wide line for a bar
setpwidth 20
pu fd 10 pd
fd :height
bk :height
pu bk 10 pd
setpwidth 1
end
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Program Structure of BarGraph

BarGraph

— T
SetUp DrawfAxes SrPrint Gioia

 

 

 
     

 

Reflection

Operations

ReadWordand Sentenceare operations, as are PWidth and Pos. An operation
always producesan output that becomesthe input to another procedure. Pos
is used as an input to SetCursor. Unlike commands, operations can’t be the sole
instruction on line.

The powerofoperations suchas Posis evident when theyare used as inputs.
Finding an exact position becomes unnecessary. In these cases, the computer
does the work for you.

Some Notes on ReadWord

When using Readword,it is important to understandthat Logo reads theline as
a word,evenifyou type a series of words. For example, type:

name readword “anything Press Enter.

then type:

this is a line with spaces
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Now use the WordP operation to checkif :Anything is a word:

print wordp :anything

Logo responds:

TRUE

WindowCoordinates and Screen Coordinates

The graphics window alwayshas the coordinates of [0 0] as its center, no
matter whatits size or location.

Thescreen has the coordinates of [0 0] on the top left corner. This means that
the screen coordinate system looks quite different from the window
coordinate system.

The screen coordinates are always the same, but since a graphics window may
be large or small, anywhere on the screen, the window coordinates only have
meaning relative to the center position.

Né File Edit

[0 0]
Graphics

[0 0] ]

 

Text
 

 

    r
o
]
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Exploring Further

Write a bar graph procedurethatis flexible enoughto processa large amount
of data. (Your program would haveto divide the x-axis line into equalparts. )

Plot a line graph from peak to peak on the bars.

Modify BarGraphso the bars aren’t drawnuntil all the data is collected, then:

[1] Scale the y-axis to the heightof the largest amount.

[2] Calculate the data in terms of percentages.

 

Logo Vocabulary

Commands

SetCursor

SetFont
SetHeading SetH
SetPos(for Set Position)

SetStyle
SetWPos(for Set Window Position )
SetWrite

SetWSize (for Set WindowSize )

Special Words

Venice

Monaco

Operations

Pos(for Position)
PWidth (for Pen Width)
ReadWord RW
Sentence Se

WordP(P for Predicate )
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9 Manipulating Text

Programsthat build, analyze, and restructure words and sentences can be used
as the basis for other projects such as questionnaires and quizzes. This chapter
develops two “text manipulation”projects. In this context, new primitive
proceduresthat act on wordsandlists are introduced, and you are shown how
to write your own operations.

Thefirst project is a random sentence generator, that generates sentencesin
the following form:

Dogs dance
Computerslaugh
People bark
People beep

The second project analyzes and restructures words.Its function is whimsical:
to change wordsending with “ght” (for example, light) to end with “te”(lite).
A phrase suchas “light beer” becomes“lite beer”.
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Plan the steps

The Item operation

 

Action

Generating Random Sentences

The random sentence generator produces sentences by combining wordsthat
are chosen randomly, This can produceinteresting and amusingresults.

This program can be written by following these steps:

Step 1: Create twolists. Write a procedurethat will pick words at random
from list.

Step 2: Write the procedure to generate sentences and then write the
superprocedure.

Step 3: Extend the sentence generator by adding adjectives and adverbs.

Step 1: Creating Lists and Picking a Random Word

Before beginning, increase the size of the text window so youcansee the
results of your work. Then create a list of nounsanda list of verbs. Since Logo
hasto store them in memory, use Name to name them. Any wordswill do in
these lists. These are just examples:

name [children dogs computers people] "nouns
name [laugh bark beep dance] “verbs

Toselect a word from list, use Item:

print item 3 :nouns

Logo responds:

computers

print item 1 :verbs

Logoresponds:

laugh
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If you use Randomas thefirst input to Item, you can select a random word:

print item random 4 :nouns

Try this line a few times. What happensifRandom 4 outputs 0? Logoprints:

ITEM doesn’t like 0 as input

To prevent Random from producing0 as its output, add 1 to Random as in
1+ Random 4. Theinstructionline selecting a random wordfrom a list can
then be generalized into a procedure:

to pick :list Define an operation to
output item €1 + random count :list) :list pick a word
end

The Output command makesPick an operation. Output outputs an element of
the inputlist extracted by Item.

The Pick procedureacceptsa list of any length asits input by using the Count
operation.

Countcounts the numberofelementsin its input and outputs that number.

Pick is a useful tool. For example:

print pick :nouns

may print:

dogs

Try Pick again. You'll probablygeta different result:

print pick :nouns

mayprint:

children
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Step 2: Writing the Sentence Generator

This procedureuses Pick to randomly pick nounsand verbs and combine them
in a sentence:

to talk
print se pick :nouns pick :verbs

talk
end

Since the procedureis recursive,it will print many random sentencesuntil you
chooseStop.
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Although the sentence generator appears complete, one problem remains: the
nounandverblists were not namedin a procedure. This meansthat every time
you run Talk, you haveto check if :Nounsand:Verbshavevalues.It’s more
convenientto write a superprocedure that namesthe nounandverblists, and
runs Talk.

to randomsengen
name [children dogs computers people] "nouns
name [laugh bark beep dance] "verbs
talk
end
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Step 3: Extending the Sentence Generator

Atthis point, you could make the sentences moreinteresting by adding
adjectives and adverbs. In RandomSenGen,add adjectives and adverbsto the
names. Put your choice ofwordsin theirlists.

to randomsengen
name [children dogs computers people] "nouns
name Claugh bark beep dance] "verbs
name [red blue green yellow] "adj
name [loudly quietly hep Ly sadly "adv
talk
end

Talk must be edited to add adjectives and adverbs to the sentence printed. To The Wait Command
slow downthe sentencesso they can beread, insert Wait before the recursive
line. Wait makes Logo pauseforthe length of time given byits input in 60ths of
asecond. Wait 60 makes Logo pause for 1 second.

to talk
pr (se pick :adj pick :nouns pick :verbs pick :adv)
wait 60
talk
end

Notice that when Se (Sentence ) has more than twoinputs, you must put
parentheses aroundSentenceandits inputs.

Trying RandomSenGen mayprint funny combinations of words:

red dogs laugh quietly
blue computers beep loudly
green children dance happily
yellow people bark sadly
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Plan the steps

The MemberP
operation

The ButLastoperation

Generating a “Dialect”

The dialect generator takes a phrase or a sentence and changesall words
ending with “ght” to end with “te”.

To write this program,follow these steps:

Step 1: Examine a wordfor “ght”. Replace “ght”in a word with “te”.

Step 2: Write a superprocedureto replaceall the “ght” wordsin list.

Step 1: Examining and Replacing Part of a Word

The simplest way to examine a wordfor the presenceofa letter or group of
letters is MemberP. MemberPis a predicate like EmptyP. MemberP(Pfor
Predicate ) checks if its first input (a wordorlist) is an elementofits second

input (a wordorlist). Try:

rint memberp "k "macintosh
FALSE

Theinstruction tells Logo to checkifthe character & is in the word macintosh.
It isn’t there, so MemberP outputsFalse.

The last three letters will be removed from a word ending in “ght” by ButLast
(or BLfor short), ButLast outputsall but the last element of a word orlist.
ButLast will be used three times in a row; three ButLast’s leave a word with the
last three letters missing.

print bl bl bl "night
ni
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Use Wordto “glue on” the new ending “te”. Word creates a new word made The Word operation
upofits inputs:

print word "ni "te
nite

Combining Word and ButLastin oneinstruction doesthe “cutting” and
“pasting” in onestep:

print word bl bl bl “night "te
nite

Examining and replacing part of a word can bethe job ofone procedure. The Define an operation to
ChangeTag procedureis an operation that uses MemberPto checkif a word examineandreplace
ends with “ght”. If “ght”is found, these letters are choppedoffthe word, and
the letters “te” are added.If the word doesn’t contain “ght”, the input wordis
output without any change.

IfElse is a conditionallike If, except it can run one oftwoinstructionlists: the IfElse: a conditional
first instruction is run whenthe predicate or condition is True; the second,

whenitis False.

to changetag wd
ifelse ie :wd> Press Tab and Spacebar.
Cop word bl Bi éet :wd “telPress Taband Spacebar.
Cop :wd]

end

Note To “format”lines so theycarry across more than onescreenline, press
the Tab key instead ofthe Return key. A continuation arrow appears and you
can put spaces at the beginningof the next line. Using Tab and spaceswill
increase the readability of long lines.

Test ChangeTag:

print changetag "alright
alrite The word with “ght”is changed.
print changetag "lettuce
lettuce A word without“ght”is left alone.
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Define a recursive
operation

Step 2: Writing a Superprocedure to Replace Wordsin List

You now can changea part ofone word. The nextstepis to take a list and
changeonly the relevant words. The superprocedure shouldtake thelist:

star light star bright

and changeit to:

star lite star brite

The Dialect superprocedureis a recursive operation that accomplishesthis
task. Dialect takesa list, passes one wordat a time to ChangeTag, and outputs
the updatedlist.

Dialect uses the primitive procedure FPut(for First Put) to create a list by
putting its first input at the beginning of its second input,a list.

to dialect :list
schanges “ght words in list to “te Thecommentline.
if emptyp :list [Cop [€ J] The[ ]is an empty list.
op fput changetag first :list dialect bf :list
end

Nowtry Dialect:

print dialect [Star light star bright]
Star lite star brite
print dialect [I see the light]
I see the lite



 

Reflection

Global Variables

Did you notice that Talk doesn’t have inputs onthetitle line, butstill uses the
lists named Nounsand Verbs? Thelists were named with Nameoutside the
procedure,but are accessible inside the procedure. This is because variables
created with Nameare global; thatis, they are accessible to every procedure
in the workspace.

Operations Written in Logo

Pick, ChangeTag, and Dialect are all operations. Theyare thefirst operations
introducedthat are not primitive procedures, Outputis the command that
makesthese procedures operations. Outputtakesits input and sendsit to
another procedure.

Pick is very useful becauseit is used as an input. This is only possible becauseit
is an operation. What would happenifPick was a command? Replace Output
with Print and experiment.

to picker :list
pr item (1 + random count :list) :list
end

picker fa bc def gl
¢

Pickeris static: we can’t do anything else with it except look at the result.

Compareit with this:

print se pick CA B Cl] pick [ab cl
Be

Global Variables 97
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Recursive Operations

Unlike Pick and ChangeTag,Dialect is recursive. When a recursive procedure
acts as an operation,the passing of information occurs not only between the
recursive procedureand its superprocedure, but also between each round of
recursive subprocedures.

In the Dialect procedure,the line:

op fput changetag first :list dialect bf: list

is difficult to understand. The telescoping model providesa visual
representation ofthe process of running the Dialect procedurein the
instruction:

print dialect [light beer]

 

Process Output
 

 

Dialect [light beer]
If EmptyP [light beer] [oP []]
OP FPut [ChangeTag “light| [Dialect BF [light beer] |-}--[lite beer]

eee “

Dialect [beer]
If EmptyP [beer] [oP [ ]] i
OP FPut [ChangeTag "beer| [Dialect BF [beer] ]))~~~[beer]

 

  

 

     
Dialect []
If EmptyP [1] [OP [ ] Joe ppepene L Too

 
Dialect[light beer] runs two subprocedures, ChangeTag“light and Dialect
[beer]. Although ChangeTag outputs something immediately, Dialect [beer], in
turn, runs two subprocedures, ChangeTag “beer and Dialect |]. When Dialect
[ ]runs, it outputs the empty list. This is passed to FPutin Dialect [beer].

Now dialect [beer] can output the result of [beer] to FPut in Dialect[light
beer]. Dialect[light beer] then outputstheresult of[lite beer] to Print so the
instruction can beprinted.

Rememberthat a recursivecall is a subprocedurecall. Each subprocedure
mustfinish running before the result of the instructionline is output.



Recursive Operations 99

 

Exploring Further

Write a program that generates rhyming poetry, using RandomSenGenas a
model.

Using Dialect as a model, write a program changingall words endingin “es” to
“ing”. Write a program that changes past tense verbs to presenttense.

 

Logo Vocabulary

Commands Operations

Output OP ButLast BL

Wait Count

FPut(for First Put)
, IfElse

Special Keys Item
e Pp icaTab (for formatting) oe (P for Predicate )
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10 Building a Phone Directory

Oneofthe uses of a programming languageis to keep records. A large set of Use a propertylist
records,storedinfiles, is often called a data base. Building a data base in Logo

can be accomplishedin different ways. One way, to be shownin this chapter,is

through theuse ofproperty lists. Apropertylistis a list of attributes and
values, associated with a name.It takes this form:

name [property1 value1 property2 value2 property3 value3...]

Forinstance,look at the table or desk you're working at. It has a name (desk)
and a numberofattributes or“properties”. It has the property of color. The
color may be brown.In that case:

name [property1 value] ]
desk [color brown]

The desk also has the properties of height, depth and width. With valuesfor
these properties added, a property list for a desk mightlook like:

desk [color brownheight 28” depth 30" width 62”]

Property lists are very useful for storing data by name and property. The
following program will use peoples’ namesas the properties and phone
numbersas values, to create a phone directory that is a large property list
which can beprinted out, saved in file, and easily updated or addedto.

You can modify the phonedirectorylater to include anything you wish; for
example, addresses, birthdays, and favorite colors.

The project will be developedin the following steps:

Step 1: Entering the data in the form of a property list. This section will be Plan the steps
interactive.

Step 2: Printing out the phonedirectory clearly on the graphics window.

Step 3: Updating the phonedirectory so that numbers can be changed
or added.
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The PProp command

 

Use a procedure to
enter data

 

Action

Step 1: Entering the Data

Suppose you wantthe phone bookidentified by your name(“Laura’s Phone
Book”). The properties (yourfriends’ names) andvalues (their phone
numbers) can then be stored under your name. PProp (which standsfor Put
Property ) gives a namea property and a value. To give yourfriend Eric a

phone number:

pprop "Laura “Eric [373-5655] Laurais your name.
Eric is yourfriend.
373-5655 is Eric’s phone
number.

Youcould go on and enter yourotherfriends’ phone numbersin this manner,
but it’s much more convenientto write a procedureto putthe data in the form
of a property list for you.

PhoneList asks for your name and yourfriends’ names, then runs a
subprocedureto add the phone numbers:

to phonelist
;builds a phone book using a property list
pr CWhat’s your name?]
name readword "myname Picks up your name.
pr se [List your friends’ names please,] :myname
name readlist "namelist Picks upalistoffriends.
addnumbers :namelist Addsthe phone numbers.
end

AddNumbersis a recursive procedurethat asks for each friend’s phone
numberin turn, and puts the name and phone numberinto the propertylist
form of a property and value:

to addnumbers :namelist
if emptyp :namelist [stop]
pr se word first :namelist "’s [number is: ]
pprop :myname first :namelist readlist
addnumbers butfirst :namelist
end



Try out:

phonelist

Logo responds:

What’s your name?

You maytype:

Laura Rememberto press Enter.

Logosays:

List your friends’ names please, Laura

You maytype:

Step 1: Entering the Data 103

Eric Judy Lorraine Alain Type themall before pressing Enter.

Then Logosays:

Eric’s number is:

You maytype:

373-5655

And so on,until all the namesin thelist of friends have numbers.

Step 2: Printing Out the PhoneList

You can view the property list you just created by using PList (for Property
List).

print plist “Laura This prints the property list
associated with Laura.

A list similar to this will be printed:

Eric [373 - 5655] Judy [738 - 1212]
Lorraine [212 - 8888] Alain [767 - 9999]

The PList operation
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Print the phonelist
in columns

Display the phonelist
on the graphics
window

That’s fine but hard to read. The list could be printed in columns:

Eric 373 - 5655
Judy 738 ~ 1212
Lorraine 212 - 8888
Alain 767 - 9999

You needto take the property list apart in order toprintit. This can be the job
of the recursive procedure, ColumnPrint.

ColumnPrint uses the PadRight operation to print words or numbersin a fixed
numberofspaces. This is how columnsof information are printed. No matter
how manycharacters there are in a number or word, PadRightwill outputit
with a fixed numberof characters, “padding” the spacesto the right of the
next word will be printed in a certain place. PadRight’s first input is the
amountofspacesallotted to the column; the second inputis a wordorlist.

to columnprint are
;prints names and phone numbers in columns
if emptyp :props [stop]
type padright 15 first :props
pr first butfirst :props
columnprint butfirst butfirst :props
end

columnprint plist “Laura

Youshould see somethinglike this:

Eric 372 ~ 5655
Judy 728 = 1212
Lorraine 212 - 8888
Alain 767 - 9999

A really elegant phone directory program would print the directory listing on a
graphics window,in fancy font, perhaps with thetitle in a different font from

thelisting.
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ShowListis the procedurethatprints thelisting on the graphics window
(ColumnPrint becomesits subprocedure). At the same time, give the display a
title (for example, Laura’s Phone Book):

to showlist :phonelist
;displays the phone list on the graphics window
c
setwrite "graphics Sets printing to graphics window.
setcursor [-90 60] Positions the cursorat top left.
setfont "Venice Sets the letter font.
setstyle [0 14] Set the printing style.
Cpr word :myname "’s [Phone Book])
pr C J
setfont "Monaco
setstyle [0 12]
columnprint :phonelist Phonelisting.
setstyle [0 9] Restoresoriginal style.
setwrite "text Restoresprinting to text window.
end

Try:

showlist plist “Laura

 

Graphics
 

Laura's Phone Book

 

Eric 373 -

Judy 730 -
Lorraine 212 -

 

Alain 76? - 9999
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The GPropoperation

Atthis point, add ShowListto the original PhoneList superprocedure, After
entering the names and phone numbers,you will see everything listed.

to phonelist
;builds a phone book using a property list
pr CWhat’s your name?]
name readword "myname
pr se [List your friends’ names please,] :myname
name readlist “namelist
addnumbers :namelist
showlist plist :myname
end

Step 3: Adding and ChangingListings in the PhoneDirectory

This program must havethe ability to change a phone number,or add a
friend’s name and number. Changing an existing phone numbercanbeeasily
done using GProp(for Get Property ) and PProp.

Forinstance:

print gprop “Laura “Judy

prints Judy’s phone number:

738 - 1212

Then:

Pprop “Laura "Judy [654 - 1111]

changes Judy’s phone number. You can check whetherJudy’s number has
been changedby:

print gprop "Laura "Judy

or

showlist plist "Laura

Note Tofind Judy’s phone numberwith GProp, Judy must be typed exactly
as it was originally entered, in capital and lowercaseletters.
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Now,write a procedure to change or add a phone numberinteractively. Write a procedure to
Update displays the current phonelist, asks whose number you wantto add or updatethe phonelist
change, makesthe change,then displays the updatedlist:

to update
;updates the existing phone list

showlist plist :myname
pr (Whose number do you want to change or add?]
name readword “name
Cpr word :name "’s Cold number is]>
error imyname :name)

pr CWhat’s the new number?]
prop :myname :name readlist
showlist plist :myname

end

To try out the program,type:

update

To erase the complete phone bookandstart fresh, use the command Erase the data
ErasePList (for Erase Property List), as in:

eraseplist plist “Laura

Program Listing

to phonelist
;builds a phone book using a property list
pr (What’s your name?]

name readword "myname
pr se [List your friends’ names please,] :myname
name readlist “namelist
addnumbers :namelist
showlist plist :myname

end

to addnumbers :namelist
if emptyp :namelist [stop]
pr se word first :namelist s [number is: ]
pprop :myname first :namelist readlist
addnumbers butfirst :namelist
end

ae
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to showlist :phonelist

s;displays the phone list on the graphics window
c
so turtte raphics
setcursor [-90 60]
setfont "Venice
setstyle [0 14]
Cpr word :myname
pr C J
setfont "Monaco
setstyle [0 12]
columnprint :phonelist
setstyle [0 9]
setwrite "text
end

us s [Phone Book])

to columnprint Pprops
sprints names and phone numbers in columns
if emptyp neta2 Cstop]
type padright 15 first :props
pr first butfirst :props
columnprint butfirst butfirst :props
end

to update
;updates the existing phone list
showlist plist :myname
pr CWhose number do you want to change or add?]
name readword "name
Cpr word :name "’s Cold number is]—>
gprop :myname :name)

pr CWhat’s the new number?]
pprop :myname :name readlist
showlist plist :myname
end

Program Structure of PhoneList

PhoneList Update

AddNumbers

   

 

  

    ColumnPrint



 

Reflection

The Elementsof a List

It may be confusing to distinguish the elements of a propertylist. The property
list

[Eric [373 - 5655] Judy [738 - 1212] Lorraine [212 - 8888]]

has 6 elements. The first elementofthis list is Eric, and the sixth is [212-8888].

The organizationofthis list makes writing a recursive procedureto print each
elementfairly simple. ColumnPrint prints two elementsofits input at each
roundofthe recursive call. Since there are two elements printed, the recursive
line (ColumnPrint ButFirst ButFirst :PList) uses two ButFirst’s to drop off two
elements each time.

Replacing an Elementin a PropertyList

An interesting aspect ofproperty lists is the way elementsinthelist can be
accessed and replaced. The way to access elements in standard Logolists is by
using wordandlist operations(First, ButFirst, Item,etc. ). Instead, with
property lists, you can access the value of a property directly using GProp, and
replace it using PProp. This makes property lists easier to update, since an
elementis replaced or added by name,notbyits placementwithina list.

The Elements of a List 109
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Exploring Further

Add addresses and birthdays to the phonelist program.

Examine other waysofcreating a data base in the sample programs(lookat the
Samples Menufile ).

 

Logo Vocabulary

Commands

ErasePList ErPL (for Erase
Property List)

PProp (for Put Property )
Type

Operations

GProp(for Get Property)
PadRight
PList (for Property List)
ReadList RL



 

A Concluding Note by SeymourPapert

WhenI have learned something new,I am full of questions. Some about the
subject matter: what haveI learned, where do I go from here? Some about
learning: what kind of a learning experience was this, what did I learn about
learning? Some about myselfand other people: have I learned something new
about myselfand my relationship with other people?

I hope Logohas left your head buzzing with such questions. Of course I can’t
answerthem for you but a few guidelines might help.

The only wayto find out what you havelearned is to use it. You have seen
examples ofLogo programs. Try your handat inventing someofyour own.If
you are a cautiousperson,start by makingfirst small, and then larger,
modifications to our programs. Ifyou are a risk taker, try something very
different. Both routes can take you a long way.

Whicheverroute you take, you must not expect, or want, everything you try to
workout. You will be experimenting with your knowledge of Logo,testing and
extendingits limits and finding out whatstylefits you best.

Whenyour projects don’t work out, take a hard lookat the reasons.If you get a
large numberof inexplicable error messages, you are probably missing a
fundamental concept. Perhaps you should go through this guide again trying to
write somesimple programs, quite similar to our examples. If your procedures
run but don’t do what you hoped they would, you can take twotacks. Oneis to
stand back from the project, rethink your goal and start again with a more
carefully structured plan. Or you canstick with yourpartially working
program and developit through understandingits strengths and weaknesses.

Youareat a particularly exciting point when your proceduresrun, but you
may suspectthere are better waysto get the sameresults. You are ready to go
on to learn more Logo than we have shown in this guide. I have four pieces of
advice about howtodothis.

111
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Thefirst is to dip into the Reference Manual. Logo has many moreprimitive
proceduresthan you have seenin this guide and there are ways to understand
the language more deeply than those shownsofar. Read Chapter 2,“Logo
Grammar”, of the Reference Manualcarefully. You can browse through the
rest. Treat the manuallike a dictionary. Whenever you use a Logo primitive
procedure,lookit up. Read its description and skim through the procedure
descriptions in the same section.

Anotherplace for browsingis the collection of sample programs on your Logo
disk or Logo programsin the growingliterature on Logo. You should learn a
computerlanguagelike you would learn a natural language:first and foremost
by expressing yourself in it but also by reading it. Read programsas wellas
writing them.

Mythird piece of advice for how to get a deeper understanding of Logo has
already beenstated several times: write lots of programs, learn by doing.

Andfinally the most important adviceofall is THINKABOUT yourprogram.
Bestofall find someonetotalk to, to think with. Onelearns best by doing... and
by thinking about what one has done.

SeymourPapert



113

 

Other Books About Logo

Here are some other booksthat have been written about Logo. They can
provideideas for projects and additional information on the concepts and
philosophy of Logo. Check your bookstore for more books.

Apples Logo, by Harold A. Abelson. Published by Byte Books, McGraw-Hill,
1982.

Turtle Geometry: The Computer as a MediumforExploring Mathematics, by
Harold A. Abelson and Andrea diSessa. Published by MIT Press, 1981.

LogoforApples Computers, by Roger W. Haigh and LorenE. Radford.
Published byJohn Wiley and Sons,Inc., 1984.

Mindstorms: Children, Computers, andPowerful Ideas, by SeymourPapert.
Published by Basic Books, 1980.

Introducing Logo, by Peter Ross. Published by Addison-Wesley, 1983.

DiscoveringApples Logo, An Invitation to the Art andPattern ofNature, by
David Thornburg. Published by Addison-Wesley, 1983.
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Wait, 93

window coordinates, 86

windows
closing, 16

editor, 23
graphics, 2

opening, 13
text, 2

word, 11

Word, 95
WordP, 86

workspace, 33
writing procedures, 21

XAxis, 72

YAxis, 71



 

Microsofts MacLibrary..
Product Problem Report
10700 Northup Way, Box 97200, Bellevue, WA, 98009

Use this formto report software problems, documentation errors, or suggested
enhancements. Please send the form to Microsoft MacLibrary.

Name 

Street
 

City State Zip

Phone Number( ) Date 

 MacLibrary Product Name

Version Number —_____________ Registration Number

Category of Problem

—___— Software Problem —— Documentation Error
(Documentand page number)

 Suggested Enhancement ——_— Other

Description of Hardware

—_— 128K Macintosh ——— 512K Macintosh

—_— Lisa 2/10 ——— Other

2nd Disk Drive ——— OtherPeripherals 

—_— Hard Disk Manufacturer_—_________ Size. 



Problem Description

Please describe or attach a listing of the problem.

  Can the problem be duplicated? Yes No



=

CAREFULLY READ ALL THE TERMS AND CONDITIONSOFTHIS MIcrosoft
AGREEMENTPRIOR TO OPENINGTHIS DISK PACKET. OPENING THIS
DISK PACKET INDICATES YOUR ACCEPTANCE OF THESE TERMS AND 1
CONDITIONS. icense

If you do not agree to these termsandconditions, return the unopened
disk packet and the other componentsofthis product to the place of purchase and
your moneywill be refunded. No refundswill be given for products that have an A reement
opened disk packetor missing components.

1, LICENSE:You have the non-exclusive right to use the enclosed program.
This program canonly be used on a single computer. You may physically transfer
the program from one computerto anotherprovided that the program is used on only one computerat a time. You may not
electronically transfer the program from one computer to another over a network. You may notdistribute copies of the
program or documentation to others. You may not modify or translate the program or related documentation without the
prior written consentof Microsoft.

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR DOCUMENTATION, OR ANY
COPY, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK UP AND TRANSFER:You may make one(1) copyof the program solely for backup purposes. You must
reproduce andinclude the copyright notice on the backupcopy. You maytransfer andlicense the productto anotherparty
if the other party agrees to the terms andconditionsof this Agreement and completes and returns a Registration Card to
Microsoft. If you transfer the aeeM you mustat the sametimetransfer the documentation and backup copyortransfer
the documentation and destroy the backup copy.

3. COPYRIGHT:The program andits related documentation are copyrighted, You may not copy the program
orits documentation except for backup purposesandto load the program into the computer as part of executing the
program. All other copiesof the program andits documentationarein violation of this Agreement.

4. TERM:Thislicenseis effective until terminated. You mayterminateit by destroying the program and docu-
mentation andall copies thereof. This licensewill also terminateif you fail to comply with any term or condition ofthis
Agreement. You agree, upon such termination,to destroyall copies of the program and documentation.

5. HARDWARE COMPONENTS:Microsoft product hardware componentsincludeonly Microsoftcircuit cards,
powersupplies, product housings,andelectrical cords.

6, LIMITED WARRANTY: THE PROGRAMIS PROVIDED “’AS |S’: WITHOUT WARRANTY OF ANY KIND.
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE PROGRAM IS ASSUMED BY YOU.
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU (AND NOT MICROSOFT OR ITS DEALERS) ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. FURTHER, MICROSOFT DOES NOT
WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF, OR THE RESULTS OF
THE USE OF, THE PROGRAMIN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE; AND YOU RELY ON THE PROGRAM AND RESULTS SOLELY AT YOUR OWNRISK.

Microsoft does warrantto the originallicensee that the disk(s) on which the programis recordedbefree from
defects in materials and workmanship undernormal use andservicefor a period of ninety (90) days from the date of
delivery as evidencedby a copyof yourreceipt. Microsoft warrantsto the originallicensee that the hardware compo-
nents includedin this package are free from defects in materials and workmanshipfora period of one(1) year from the
date ofdelivery to you as evidencedby a copyof yourreceipt. Microsoft's entire liability and your exclusive remedyshall
be replacementof the disk or hardware componentnot meeting Microsoft's Limited Warranty and whichis returned to
Microsoft with a copyof your receipt.If failure of the disk or hardware componenthasresulted from accident, abuse, or
misapplication of the product, then Microsoft shall have no responsibility to replace the disk or hardware component under
this Limited Warranty. In the event of replacementof the hardware component, the replacementwill be warrantedfor the
remainderofthe original one (1) year period orthirty (0) days, whicheveris longer.

THE ABOVE IS THE ONLY WARRANTYOFANYKIND, EITHER EXPRESSEDOR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSETHATIS MADE BY MICROSOFT ON THIS MICROSOFT PRODUCT. THIS WARRANTYGIVES YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHERRIGHTSTHAT VARY FROMSTATETO STATE.

NEITHER MICROSOFT NOR ANYONE ELSE WHO HAS BEEN INVOLVEDIN THE CREATION, PRODUC-
TION, OR DELIVERY OF THIS PROGRAM SHALLBE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR
INCIDENTAL DAMAGESARISING OUT OF THE USE, THE RESULTS OF USE, OR INABILITY TO USE SUCH PROD-
UCT EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGESOR CLAIM. SOME
STATES DO NOT ALLOW THE EXCLUSIONORLIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

7. UPDATE POLICY:In orderto be able to obtain updates of the program,the licensee and persons to whom
the programis transferred in accordancewith this Agreement must complete andreturn the attached Registration Card
to Microsoft. IF THIS REGISTRATION CARD HAS NOT BEEN RECEIVED BY MICROSOFT, MICROSOFT IS UNDER:
NO OBLIGATION TO MAKE AVAILABLE TO YOU ANY UPDATES EVEN THOUGH YOU HAVE MADE PAYMENT OF
THE APPLICABLE UPDATE FEE.

8. MISC; This License Agreementshall be governedbythe lawsof the State of Washington and shall inure to
the benefit of Microsoft Corporation, its successors, administrators, heirs, and assigns.

9. ACKNOWLEDGEMENT: YOU ACKNOWLEDGETHAT YOU HAVE READ THIS AGREEMENT,
UNDERSTANDIT, AND AGREE TO BE BOUNDBYITS TERMS AND CONDITIONS. YOU ALSO AGREE THATTHIS.
AGREEMENTIS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEENTHE PARTIES AND
SUPERCEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMU-
NICATIONS BETWEENTHE PARTIES RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT,

Should you have any questions concerningthis Agreement, please contactin writing Microsoft Corporation,
CustomerSales and Service, 10700 Northup Way, Box 97200, Bellevue, WA 98009.



CAREFULLY READ THE MICROSOFT LICENSE AGREEMENT
ON THE FRONT OF THIS PACKET BEFORE OPENING!
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™ Three Important
Reasonsto
Register Your
Product Now

&l Microsoft
The help you need, whatever your application. We Help Hotline

want you to get the maximum performance from yourMicrosoft software. If you have any

technical problem, we'll be glad to help. However, mostof the time you'll find the answer

right in your product documentation,so please take lookatthatfirst. You might also give

your Microsoft dealera call. If you're still puzzled, gather all the information pertinent to the

problem and call our Product Support staff at (206)828-8089. They'll be ready to give you

the support you need to get the most from your Microsoft software.

© Microsoft
Product

Replacement
Plan If you needit, when you needit. In spite of rigorous

testing and the highest quality-control standards, even Microsoft products sometimes need

replacement.If your product proves defective,it will be replaced at no charge during the

warranty period, and for a reduced price thereafter. However, you mustprovide us with

proof-of-purchase and return the defective componentto us. 

If you think you may havea defective product, you'll probably wantto call ourhelp hotline

at (206)828-8089 before mailing the product to us. When you have confirmedthat a problem

exists, follow the instructions outlined in the attached product replacementcard. Mail the

card, the defective component, your proof-of-purchase,and full details about the problem

you are experiencing to:

Customer Service Department

Microsoft Manufacturing

13221 S.E. 26th Street
Bellevue, WA 98005

Or call Microsoft Customer Service at (206)828-8088 for moreinformation.

©! Microsoft
Product

It keeps your program up to date. Your Microsoft soft- Upgrade Pian

ware product uses the most advanced technology available today. But we continually

improve our software, making it even more powerful and easy to use. You can take advan-

tage of our ongoing research—if you sendin your registration card today!

As a registered Microsoft user, you receive announcements about major improvements

in your program. These announcementsgive you the costof the update and ordering

procedures. In most cases the enhancedversionis available to you at a reducedprice. Only

registered owners receive these special update notices. (Microsoft offers updates only for its

productivity tools and languages. Recreationalsoftwareis not eligible for updates. Owners of

recreational products do not receive update announcements.)

Just Register Now.



™ Microsoft
Software
Limited
Warranty I This limited warranty appliesto the original purchaser

only and to the recording medium (disk) only, not to the

information encoded on it. This warranty coversdisksincluded in Microsoft hardware/

software packages, such as the Microsofta SoftCard® system products and the

Microsofte RAMCard® memory board for the IBM@ PC.

i Microsoft hardware componentsinclude only a Microsoft
Circuit cards and the mechanical mouse. Hardware

I |f a hardware componentis included with your Limited

Microsoft product, the componentis warranted

Warranty

Wi Thedisk on which your Microsoft program is recorded

is warranted to be free of defects in materials and work-

manship under normal use for a period of 90 days from

date of product purchase.

to be free of defects in materials and work-

manship undernormalusefor a period of one

year from date of product purchase.

i This limited warranty applies to the original product purchaser only and to the hardware

componentonly, not to the application for whichit is used.

® Disclaimerof The Microsoft programsarelicensed solely on an

“as is’’ basis. The entire risk as to their quality and

performanceis assumedbythe purchaser. MICRO-Liability for
SOFT CORPORATION DOES NOT GUARANTEE,

Use and the WARRANT, NOR MAKE ANY REPRESENTATION
REGARDING THE USE OF, OR THE RESULTS OF

Results of Use THE USE OF, THE PROGRAMSIN TERMSOF COR-
RECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE; AND THE PUR-
CHASER RELIES ON THE PROGRAMS AND THE RESULTS SOLELY AT HIS OR HER OWN
RISK. Microsoft Corporation assumesnoliability for any direct, indirect, incidental or

consequential, special or exemplary damages,regardlessofits having been advised of the

possibility of such damages.

A full description of the limited warranty for hardware and software and the termsof the abovedisclaimerof

liability are in the License Agreement that accompaniesthis booklet.

Microsoft, Multiplan, SoftCard, and RAMCardare registered trademarks and MS-DOSand The High Perform-

ance Software are trademarksof Microsoft Corporation

Copyright 1984 Microsoft Corporation. 

™@ New Answers
from the Oldest

We wrote the first BASIC forthe very first personal Name in Micro-

computer

Software
than two million machines. The samecare and attention we putinto Microsoft BASIC,

computer. Todayit’s the world’s most widely

installed computer language, running on more

weputinto every productwesell today. The result?

Microsoft consistently delivers powerful, reliable, easy-to-use solutions for business,

industry, and education.

a Register Solutionslike MS-DOS..., the most popular operating system for 16-

It Now! bit computers. Like Microsoft Multiplan, theflexible, plain-English

electronic worksheet.Orlike Microsoft Word, the writing system that’s revolutionized word

processing.

Every Microsoft productis designed to be easyto learn and use, andto takefull advantage

of your computer's capabilities. Your new Microsoft program incorporates the most

advanced conceptsin software today, to give you peak performanceandto unlock the

powerof your machine.

MICRSSOFT.
The High Performance Software »



Please use this card when ordering a replace- Product

ment for a defective Microsoft product. Mail it

with the defective component(s) to the address Replacement

below.To validate a replacementrequestfor a

| productunderlimited warranty, include proof-of- Order Card
\ purchase. A productreturned without proof-of-purchaseis noteligible for warranty service.

| If the product warranty has expired, orif the product does not qualify for warranty service,

i you will be chargeda service fee. No out-of-warranty service will be performed priorto

| receipt of payment. You mayinclude credit card information if you would like to charge the

service. You may call Microsoft CustomerService at (206)828-8088toiInquire about the

current chargefor the service required. | 4

 

 

 

Name
(Please includeall information requiredfor delivery including company name,mailstop,

and apartmentor suite number, if applicable.)

Address
Street

City State Zip Country

Phone( ) Telex
 

Registration number on disk

Nameof productas it appears on package

Date of product purchase / /
Month Day Year

Reasonfor return
 

 

 

If the warranty has expired, | authorize you to charge my credit card. Charges vary. The

minimum service chargeis $25.00. (J) American Express Visa (_] MasterCard

Credit card number LL] mee) CEsExpiration date

Authorized signature

Mail to: Customer Service Department

Microsoft Manufacturing

13221 S.E. 26th Street
Bellevue, WA 98005  



Microsoft Corporation

10700 Northup Way

Box 97200

Bellevue, WA 98009
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